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Об этом руководстве
это руководство призвано облегчить Ваше первое знакомство с openSUSE®.
Изучите различные части данного руководства, чтобы научиться устанавливать,
использовать и получать удовольствие при работе с Вашей системой.

Установка и настройка
Проведет Вас через весь процесс установки и базовой конфигурации
Вашей системы. Представляет YaST, центральный инструмент для установки
и конфигурации системы. Узнайте, как создать или изменить ключевые
компоненты Вашей системы и как подключиться к интернету.

Основы
Эта часть в основном предназначена для тех пользователей, которые
переходят на Linux с других операционных систем. Здесь описаны основные
концепции Linux,такие как концепция пользователей в Linux, структура
файловой системы и права доступа для файлов и каталогов. Также
приведены основы работы с оболочкой, однако она едва ли понадобится Вам
для взаимодействия с системой в настоящее время.

Помощь и решение проблем
Общие сведения о том, где найти помощь и дополнительную документацию
в случае необходимости получения дополнительной информации, или для
выполнения конкретных задач с Вашей системой. Также эта часть содержит
подборку наиболее частых проблем и ошибок, она может подсказать, как
решить эти проблемы в Вашем случае.

Это руководство описывает openSUSE 11.4.

Многие главы этого руководства содержат ссылки на дополнительную
документацию. Это включает как документацю, которая доступна в системе так
и документацию, доступную в Интернете.

Для обзора доступной документации, а также доступных обновлений текущей
документации, посетите http://www.novell.com/documentation/

opensuse114  или последующие разделы.

1 Доступная документация
Мы предоставляем HTML и PDF-версии наших книг на разных языках. Для
данного дистрибутива доступны следующие руководства для пользователей и
администраторов:

Вступление (стр. 1)
Руководство шаг за шагом провведет Вас через установку openSUSE с
DVD или из ISO-образа, даст краткое введение в окружения рабочего
стола GNOME и KDE, включая некоторые ключевые приложения. Также
познакомит с LibreOffice и его модулями для создания текста со сложным

http://www.novell.com/documentation/opensuse114
http://www.novell.com/documentation/opensuse114
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форматированием, работы с электронными таблицами или создания графики
и презентаций.

Reference (↑Reference)
Даст Вам общее понимание работы openSUSE, затрагивая задачи
продвинутого системного администрирования. Его материал предназначен в
первую очередь для системных администраторов и домашних пользователей,
обладающих базовыми навыками администрирования. Содержит детальную
информацию о продвинутых вариантах развертывания, администрирования,
взаимодействия ключевых компонентов и настройке различных сетевых и
файловых служб openSUSE.

Руководство по безопасности (↑Руководство по безопасности)
Описываются основные понятия системы безопасности, охватывающей как
локальные, так и сетевые аспекты. Показывается, как использовать такие
утилиты для обеспечения сетевой безопасности, как Novell AppArmor (которая
позволяет определить к каким файлам заданная программа будет иметь
доступ на запись, чтение или выполнение) или система аудита, которая
тщательно собирает информацию о событиях, так или иначе связанных с
обеспечением надлежащего уровня безопасности системы.

System Analysis and Tuning Guide (↑System Analysis and Tuning Guide)
Руководство администратора по обнаружению проблем, их разрешение и
оптимизация работы. В нем найдется информация о том, как проверить
и оптимизировать работу системы с помощью специальных инструментов,
эффективно управлять ее ресурсами. Также в нем содержится обзор общих
проблем и их решений, а также дополнительные справочные материалы и
обзор доступных ресурсов.

Виртуализация с KVM (↑Виртуализация с KVM)
Данное руководство предлагает краткое описание настройки и управления
системой виртуализации на базе KVM (Kernel-based Virtual Machine) в
openSUSE. Также показывается, как управлять VM Guest с помощью libvirt
и QEMU.

Большинство HTML-версий руководств в установленной системе можно найти
по адресу /usr/share/doc/manual  или в справочном центре Вашего
окружения рабочего стола. Последние обновления документации доступны по
адресу http://www.novell.com/documentation , где можно загрузить в
PDF или HTML-версии руководств для Вашего продукта.

2 Обратная связь
Некоторые из доступных каналов обратной связи:

Bugs and Enhancement Requests
Чтобы сообщить об ошибке или отправить запрос об улучшении,
пожалуйста, используйте https://bugzilla.novell.com/ . Для
ошибок в документации отправьте Ваш отчет для компонента Documentation
для соответствуюущего продукта.

http://www.novell.com/documentation
https://bugzilla.novell.com/
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Если Вы плохо знакомы с Bugzilla, то Вам могут быть полезные этим статьи:

• http://ru.opensuse.org/openSUSE:Сообщить_об_ошибке

• http://ru.opensuse.org/openSUSE:Bug_reporting_FAQ

Комментарии пользователей
Мы хотим услышать Ваши комментарии и предложения об этом руководстве
и другой документации, поставляемой с данным продуктом. Используйте
функцию комментариев пользователей в нижней части каждой страницы
в онлайн-документации или перейдите по ссылке http://www.novell
.com/documentation/feedback.html  и оставьте Ваш комментарий.

3 Условные обозначения
В данном руководстве используются следующие типографские соглашения:

• /etc/passwd : имена каталогов и файлов

• заполнитель: замена заполнитель на фактическое значение

• PATH: переменная окружения PATH

• ls, --help: команды, опции и параметры

• user: пользователи или группы

• [Alt], [Alt] + [F1]: клавиша или клавиатурная комбинация; названия клавиш
показаны в верхнем регистре, как на клавиатуре

• Файл, Файл > Сохранить как: пункты меню, кнопки

• Танцующие пингвины (Глава Пингвины, ↑Другое руководство): это ссылка на
главу в другом руководстве.

4 О создании этого руководства
Эта книга была создана в Novdoc, основан на DocBook (смотрите http://www
.docbook.org ). Исходные XML-файлы проверяются программой xmllint,
обработанные xsltproc и преобразованный в XSL-FO с использованием
специализированной версии таблиц стилей Нормана Уолша (Norman Walsh).
Конечный PDF-файл отформатирован через XEP от RenderX. Инструменты
с открытым исходным кодом и среда, используемая для создания этого
руководства, доступны в пакете susedoc, поставляемым в составе openSUSE.

5 Исходный код
Исходный код openSUSE находится в открытом доступе. Чтобы его
загрузить, выполните следующее: http://ru.opensuse.org/Portal:

http://ru.opensuse.org/openSUSE:????????_??_??????
http://ru.opensuse.org/openSUSE:Bug_reporting_FAQ
http://www.novell.com/documentation/feedback.html
http://www.novell.com/documentation/feedback.html
http://www.docbook.org
http://www.docbook.org
http://ru.opensuse.org/Portal:???????????/???????????
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Дистрибутив/Возможности . Если потребуется – мы можем отправить
исходные коды на DVD. Мы берем $15 или €15 за запись, упаковку и
доставку дисков. Чтобы запросить DVD с исходным кодом, отправьте e-mail на
электронный адрес sourcedvd@suse.de [mailto:sourcedvd@suse.de ] или
обычное письмо:

  SUSE Linux Products GmbH
  Product Management
  openSUSE
  Maxfeldstr. 5
  D-90409 Nürnberg
  Germany
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Воспользуйтесь этим руководством для установки новой версии openSUSE®
11.4. Этот документ дает краткое описание обычной установки openSUSE.

1 Добро пожаловать в openSUSE

Для получения более детальных инструкций по установке, обратитесь
к документации openSUSE по адресу http://www.novell.com/

documentation/opensuse114/ .

1.1 Системные требования

• Pentium* III 500 МГц или более мощный (рекомендуется Pentium 4 2.4 ГГц или
мощнее или любой процессор поддерживающий набор инструкций AMD64
или Intel* EM64T)

• 512 МБ оперативной памяти (рекомендуется 1 ГБ)

• 3 ГБ доступного места на диске (рекомендуется больше в зависимости от
количества устанавливаемых программ)

• Разрешение экрана 800 x 600 пикселей (рекомендуется 1024 x 768 или
больше)

1.2 Установка openSUSE

Используйте эти инструкции, если на Вашем компьютере не установлены другие
Linux системы или, если Вы хотите заменить существующую Linux систему.

1 Вставьте DVD с openSUSE в привод и перезагрузите компьютер для
запуска программы установки.

http://www.novell.com/documentation/opensuse114/
http://www.novell.com/documentation/opensuse114/
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2 Выберите Установка на экране загрузки и нажмите [Enter]. Это приведет
к загрузке и запуску процесса установки openSUSE в обычном режиме.

3 Выберите язык и раскладку клавиатуры, которые будут использоваться
в процессе установки и в установленной системе.

Прочтите лицензионное соглашение и, если Вы принимаете его
условия, перейдите к следующему шагу нажав Далее. Если Вы
не согласны с условиями лицензионного соглашения, то нажмите
Прервать для завершения установки.
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4 Выберите Новая установка и нажмите Далее.

5 Используйте карту или выпадающие списки Регион и Часовой пояс,
чтобы задать время и часовой пояс используемые в Вашей системе.
Затем нажмите Далее.
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6 Выберите окружение рабочего стола, которое Вам нравится больше.
KDE и GNOME – мощные окружения рабочего стола, похожие на
Windows; другие варианты доступны в меню Другое. Затем нажмите
Далее.

7 На этом этапе предлагается определить раздел для установки
openSUSE. В большинстве случаев предлагаемый системой вариант
может быть использован без каких-либо изменений. Для принятия
данной разметки нажмите Далее для перехода к следующему шагу.
Опытные пользователи могут отредактировать схему разметки диска
(Редактировать разметку...) или создать собственную схему (Создать
разметку).
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8 Введите свои имя и фамилию в поле Полное имя пользователя, имя
пользователя и пароль, соответственно, в поля Имя пользователя и
Пароль.

В целях безопасности, пароль должен состоять из заглавных и
строчных букв и цифр. Его длинна должна быть не меньше восьми
символов. Пароли чувствительны к регистру. Для продолжения
нажмите Далее.

По умолчанию, указанный здесь пароль также используется в качестве
пароля администратора системы – root. Отключите данную опцию,
если Вы хотите на следующем шаге задать другой пароль для root.

При активации автоматического входа после включения системы будет
загружен Ваш рабочий стол, без какой-либо авторизации. Если Вы
храните важную информацию на Вашем компьютере, то Вы должны
отключить эту опцию, так как при этом посторонние люди могут
получить доступ к этим данным.
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9 Введите пароль для учетной записи администратора (также
называемой пользователем root). Этот шаг может быть пропущен,
если Вы активировали опцию Использовать этот пароль для
системного администратора на предыдущем шаге.

Если Вы забудете пароль пользователя root, то его уже нельзя будет
восстановить. Его можно будет сбросить только при наличии прав
администратора системы. Для перехода к следующему шагу нажмите
Далее.

10 На экране параметров установки будут выведены сделанные
Вами установки, среди которых так же присутствуют настройки
установленные автоматически. При необходимости, внесите нужные
изменения.
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Нажмите Установка, чтобы продолжить. В зависимости от выбранного
программного обеспечения, Вам может быть предложено принять
дополнительные лицензионные соглашения (кнопка Принять). Перед
началом установки Вы можете увидеть следующее:

11 Нажмите Установка для запуска установки.

12 Обычно установка длится от 15 до 30 минут, в зависимости
от производительности системы и выбранного программного
обеспечения. В процессе установки Вы можете скоротать время
за изучением презентации, примечания к выпуску или просмотром
подробного журнала установки.
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13 После завершения установки всех выбранных пакетов программного
обеспечения будет загружена новая система openSUSE и произведена
автоматической настройки, как например, настройка сетевой
подсистемы, доступ в Интернет и определение настроек оборудования.
Этот этап выполняется полностью автоматически и не требует Вашего
участия в нем.

14 Если на этапе задания установок системы был выбран автоматический
вход в систему, то сразу будет загружен рабочий стол. В противном
случае, Вы увидите экран входа в систему. Нажмите на имени
Вашего пользователя и введите в поле Пароль. Нажмите [Enter], чтобы
выполнить вход в систему.
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openSUSE® предоставляет пользователям Linux* утилиты, в которых они
нуждаются ежедневно. Они (утилиты) поставляются вместе с удобным в
работе графическим окружением (рабочий стол KDE*) облегчающим общение
с системой Linux: доступ и управление файлами, каталогами и программами.
openSUSE предоставояет интегрированный набор приложений для широкого
круга задач (офис, мультимедиа, Интернет). Так же включен пакет приложений
LibreOffice, который позволяет Вам редактировать и сохранить файлы во многих
форматах. Поскольку этот набор офисных приложений доступен для нескольких
операционных систем, то Вы можете использовать одни и те же данные на
различных компьютерных платформах.

1 Вступление

Когда Вы запускаете систему, обычно запрашиваются Ваши имя пользователя
и пароль. Если Вы не устанавливали систему самостоятельно, узнайте у
системного администратора Ваши имя пользователя и пароль.

После первого входа в KDE Вы увидите рабочий стол KDE, на котором
представлены следующие основные элементы:
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Папка "Рабочий стол":  По умолчанию, виджет Рабочий стол отображает
содержимое каталога ~/Рабочий стол . Когда Вы поместите файл в эту
директорию, он сразу появится в виджете.

Контекстное меню рабочего стола:  Нажмите правой кнопки мыши на пустом
месте рабочего стола, чтобы вызвать контекстное меню и настроить внешний
вид рабочего стола, добавить панели или виджеты, изменить настройки рабочего
стола, заблокировать виджеты в их текущем положении на рабочем столе,
завершить текущий сеанс или заблокировать экран.

Инструментарий рабочего стола:  Переместите указатель мыши к значку в
верхнем правом углу рабочего стола, чтобы вызвать меню, с помощью которого
можно добавить или удалить виджеты.

Панель KDE:  По умолчанию, панель на Вашем рабочем столе KDE состоит
из изображения Главное меню слева, далее расположены виджеты и значки
программ, а так же значок настроек меню справа. Если Вы подведете курсор
мыши к любому значку на панели, то увидите краткое описание.

2 Запуск программ
Для запуска программ из Главного меню или командной строки, используйте
оболочку или диалог Выполнить команду. Дополнительно, Вы можете запустить
программы с рабочего стола или панели по нажатию на значке программы.

2.1 Работа с главным меню

Для открытия Главного меню, нажмите на значок Главное меню на панели или
нажмите [Alt] + [F1]. Главное меню состоит из следующих элементов: функции



KDE Быстрый старт  11

поиска вверху и нескольких вкладок внизу, обеспечивающих быстрый доступ
к основным функциям меню. Дополнительно, в меню отображается Ваше имя
пользователя и сетевое имя машины.

На вкладке Избранное отображаются, выбранные по умолчанию, основные
программы для быстрого доступа, тогда как Приложения показывает все
приложения установленные в системе. Для перемещения по структуре меню,
нажмите на элемент и используйте значки в виде стрелки вправо или влево,
чтобы перейти назад или вперед. Компьютер и Последние предоставляют
быстрый доступ к некоторым часто используемым местам, приложениям или
документам. Выход показывает несколько опции выхода из системы, такие
как завершение сеанса, блокирование экрана (доступ можно получить только
снова введя пароль), выключение или перезагрузка компьютера. Возможно
приостановление работы компьютера с сохранением Вашей сессии в памяти или
на диск.

Если Вам часто нужна какая-то программа и Вы не хотите рыться в структуре
меню в поисках этой программы, то просто добавьте ее ярлык на вкладку
избранное. Нажмите правой кнопкой мыши на значке этой программы и выберите
Добавить в избранное.
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2.2 Использование диалога "Выполнить"

KRunner - приложение помощник позволяющее Вам быстро запустить нужную
программу. Кроме того, эта программа предлагает функцию поиска и Вы можете
легко найти приложение.

Нажмите [Alt] + [F2] для открытия диалога Выполнить команду. Введите нужную
команду, например, dolphin. Пока Вы вводите команду, диалог выводит список
приложений или действий подходящих под Ваш ввод. Выберите нужный пункт
или нажмите [Enter], чтобы запустить выделенное приложение или действие.
Введенная команда запустит приложение, часто (но не всегда) команда это
просто имя приложения, написанное строчными буквами.

KRunner обладает так же огромным числом различных расширений
добавляющих дополнительную функциональность. Нажмите на значок
вопросительного знака, чтобы увидеть список доступных функций. Например,
вы можете использовать так называемые Web-сокращения определенные в
Konqueror для отправки поисковых запросов непосредственно к поисковому
сайту без открытия браузера. Для получения дополнительной информации
обратитесь к Раздел 8.3, «Задание персональных настроек» (стр. 27).

2.3 Поиск приложений

Главное меню и диалог Выполнить команду предлагают функцию поиска, которая
позволяет Вам быстро запускать программы, даже если Вы уже не знаете точное
имя приложения или команду для его запуска. Чтобы найти приложение, начните
набирать команду или часть имени приложения в поле Поиск: Главного меню или
введите в поле диалога Выполнить команду. Каждый введенный символ сужает
поиск.

В списке расположенном ниже поля ввода выберите приложение которое Вы
искали.
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3 Управление внешними устройствами
Если Вы вставите CD или DVD в привод или подключите внешнее устройство
(например, USB-брелок или переносной жесткий диск), то виджет оповещения
о новых устройствах откроется маленьким окошком со списком подключенных
устройств. В этом окне также выводятся возможные действия, в зависимости от
типа устройства.

Так, например, если Вы подключите цифровую камеру, то Вам будет предложено
загрузить фотографии с помощью Gwenview или digiKam. Нажмите на пункт
с именем устройства, чтобы получить список доступных действий. Чтобы
безопасно отключить устройство от компьютера вопользуйтесь значком в правой
части строки с именем устройства.

4 Придание индивидуальности Вашему
рабочему столу
Вы можете изменить внешний вид и поведение Вашего рабочего стола KDE в
соответствии с Вашими предпочтениями.

4.1 Блокировка и разблокировка элементов рабочего стола

Элементы рабочего стола могут быть заблокированы в их текущих позициях,
чтобы воспрепятствовать их перемещению на рабочем столе. Пока элементы
рабочего стола заблокированы Вы не можете добавлять, перемещать или
удалять их.

Чтобы заблокировать или разблокировать элементы рабочего стола, нажмите
на значок кешью (кнопка инструментов Plasma) в верхнем правом углу рабочего
стола и выберите Заблокировать изменение виджетов или Разблокировать
изменение виджетов, соответственно.
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Или нажмите правой кнопкой мыши на пустом месте рабочего стола и выберите
Заблокировать изменение виджетов или Разблокировать изменение виджетов.

4.2 Изменение индивидуальных элементов рабочего стола

Далее Вы можете найти некоторые примеры, как изменить индивидуальные
элементы рабочего стола.

Процедура 1 Добавление значка программы на рабочий стол

Чтобы создать ярлык для приложения и поместить его на рабочий стол или
панель, воспользуйтесь следующей инструкцией:

1 Нажмите кнопку Главное меню и найдите там нужное приложение.

2 Нажмите правой кнопкой мыши и выберите Добавить на рабочий стол
в появившемся контекстном меню. Если этот пункт меню недоступен,
вероятно изменение элементов рабочего стола заблокировано. Снимите
блокировку как описано в Раздел 4.1, «Блокировка и разблокировка
элементов рабочего стола» (стр. 13).

3 Чтобы изменить положение значка на рабочем столе, нажмите левой
кнопкой мыши на значке и перетащите его на нужное место.

Чтобы удалить значок с Вашего рабочего стола, нажмите правой кнопкой мыши
на значке программы и выберите Удалить виджет "Значок".

Процедура 2 Добавление виджетов на рабочий стол

1 Чтобы добавить виджеты на рабочий стол, нажмите правой кнопкой мыши
на пустом месте рабочего стола и выберите Добавить виджеты....

Чтобы добавить виджет на пенель нажмите правой кнопкой мыши на
пустом месте панели и выберите Настроить виджет "Панель" > Добавить
виджеты....

Если такой пункт в меню недоступен, вероятно изменение элементов
Вашего рабочего стола заблокировано. В этом случае нажмите правой
кнопкой мыши и выберите Разблокировать изменение виджетов.

2 В появившемся списке выберите нужный виджет. Используйте прокрутку
для исследования доступных виджетов. Чтобы ограничить число
отображаемых виджетов, введите в поле термин для поиска или выберите
категорию.

3 Чтобы поместить выбранный виджет на рабочий стол или на панель,
дважды нажмите левой кнопкой мышки по нему и закройте диалог.

Чтобы удалить виджет с Вашего рабочего стола, нажмите правой кнопкой мыши
на виджете и выберите пункт Удалить виджет....
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Процедура 3 Настройка виджетов рабочего стола

1 Поместите указатель мыши над виджетом – появится прозрачная область
рядом с виджетом, в которой будут находиться несколько символов:

Если эта область не появилась, вероятнее всего изменение виджетов
заблокировано. Сначала разблокируйте их, как написано в Раздел 4.1,
«Блокировка и разблокировка элементов рабочего стола» (стр. 13).

2 Чтобы изменить размер виджета нажмите левой кнопкой мыши на символ
масштабирования в прозрачной области и, не отпуская кнопку мыши,
медленно переместите курсор вдоль рабочего стола.

3 Чтобы повернуть виджет в любом направлении нажмите левой кнопкой
мыши на символ круговой стрелки в прозрачной области и, удерживая
кнопку мыши нажатой, переместите курсор описывая окружность. Есть
«липкая» граница в горизонтальной и вертикальной позиции, где Вы
можете зафиксировать виджет. Конечно, Вы можете расположить виджет
под любым углом.

4 Чтобы изменить содержимое, параметры или свойства виджета, нажмите
левой кнопкой мыши на символ гаечного ключа в прозрачной области.
В появившемся диалоговом окне произведите необходимые настройки,
согласно Вашим предпочтениям.

Процедура 4 Добавление и удаление панелей

1 Если Вам нужно несколько панелей на рабочем столе, то нажмите правой
кнопкой мыши на пустом месте рабочего стола и выберите Добавить
панель, затем выберите тип панели из списка.

Если этот пункт меню недоступен, значит элементы Вашего рабочего
стола заблокированы. В этом случае, нажмите правой кнопкой мыши и
выберите Разблокировать изменение виджетов.

2 Нажмите на значок кешью с правой стороны новой панели, чтобы получить
доступ к опциям настройки панели как описано в Процедура 5, «Настройка
панелей» (стр. 16).
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3 Чтобы удалить панель нажмите правой кнопкой мыши на пустом
пространстве панели которую Вы хотите удалить и выберите Настроить
виджет "Панель" > Удалить виджет "Панель". openSUSE требует, чтобы по
крайней мере одна панель оставалась на рабочем столе.

Процедура 5 Настройка панелей

Вы можете настроить панель KDE в соответствии с Вашими предпочтениями.
Приложения и виджеты могут быть добавлены в область быстрого запуска или
системный лоток на главной панели, или в дополнительной панели. Элементы
панели и дополнительные панели можно свободно перемещать или полностью
удалить в любое время.

1 Чтобы получить доступ к опциям текущей панели нажмите правой
кнопкой мыши на пустом месте панели (или нажмите на значок кешью
с правой стороны панели) и выберите Настроить виджет "Панель"
> Настроить панель. Здесь Вы можете изменить внешний вид и
расположение панели.

Если такой пункт в меню и значок недоступны, вероятно изменение
элементов Вашего рабочего стола заблокировано. В этом случае
нажмите правой кнопкой мыши и выберите Разблокировать изменение
виджетов.

2 Чтобы переместить элемент панели в другое место поместите
курсор мыши над соответствующим элементом (например, значком
программы, переключателем рабочих столов, системным лоток). Под
курсором мыши появится перекрестие. Нажмите на него и переместите
курсор в нужную позицию на панели. Нажмите еще раз, чтобы
зафиксировать это положение.

3 Чтобы увеличить расстояние между двумя виджетами, воспользуйтесь
кнопкой Добавить разделитель. Виджет разделитель появится с правой
стороны. Перетащите его в нужное место.

4 Чтобы изменить ширину панели, нажмите и потяните за маленький
значок стрелки с левого или правого конца панели. Используйте
стрелку с левой стороны, чтобы задать положение панели, стрелки с
правой стороны для задания максимального и минимального размеров
панелей.

5 Чтобы изменить высоту панели, нажмите на кнопку Высота и
переместите курсор до нужного положения.

6 Чтобы поместить панель с другой стороны экрана, воспользуйтесь
кнопкой Край экрана. Потяните за нее и отпустите в нужном месте.
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7 Если Вам нужно добавить виджеты на панель, то сделайте это с
помощью кнопки Добавить виджеты.... Процедура 2, «Добавление
виджетов на рабочий стол» (стр. 14).

8 Чтобы удалить значки приложений или виджет с панели нажмите
правой кнопкой мыши на нужном элементе и выберете пункт меню для
удаления этого элемента.

Значки в системном лотке обычно относятся к запущенным в фоне
приложениям. Поэтому Вы можете удалить эти значки только, если
закроете эти приложения (нажмите правой кнопкой мыши по значку и
выберите Выход).

9 Чтобы воспрепятствовать случайному перемещению панели и
виджетов, используйте кнопку Заблокировать изменение виджетов.

10 Для установки дополнительных настроек (как автоскрытие панели) и
положения панели используйте кнопку Дополнительно.

11 Если все изменения панели соответствуют Вашим пожеланиями, то
закройте панель настройки с помощью красной кнопки расположенной
с правой стороны.

Процедура 6 Изменение фона рабочего стола

Вы можете изменить фон рабочего стола на изображение, слайдшоу, мозаику
или просто залить однотонным цветом. Так же присутствует возможность
установить в качестве фона карту земного шара или прогноз погоды.

1 Нажмите правой кнопкой мыши на пустом месте рабочего стола и
выберите Настроить виджет "Рабочий стол". Откроется диалоговое окно
настроек.

2 В секции Вид выберите требуемый тип в выпадающем списке Обои. Затем
установите дополнительные параметры для выбранного объекта, который
будет использован в качестве фона рабочего стола.

3 Например, чтобы установить изображение в качестве обоев:

3a Выберите Изображение в списке Обои.

3b Задайте Расположение для изображения.

3c Чтобы выбрать уже имеющиеся обои выберите их в списке
ниже или нажмите Загрузить новые обои..., чтобы загрузить и
установить новые обои.

3d Чтобы выбрать другое изображение нажмите Открыть... и
выберите нужное в файловой системе.
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4 Установите другие настройки в диалоговом окне в соответствии с Вашими
предпочтениями и нажмите OK, чтобы сохранить изменения и закрыть это
окно.

4.3 Изменение персональных настроек

Параметры системы – центральное место, где пользователь может изменить
большое количество установок поведения и характеристик для многих
компонентов рабочего стола KDE. Его можно запустить выбрав в Главном меню
Избранное > Параметры системы.

Настройки сгруппированы по категориями. Наведите курсор на значок,
чтобы увидеть детали. Выполнение некоторых действий над персональными
настройками требует наличия прав системного администратора (root).
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Измените нужные параметры. Изменения не вступят в силу пока Вы не нажмете
Применить. Чтобы сбросить еще не примененные настройки нажмите Сбросить.
Чтобы сбросить значения для всех пунктов на значения по умолчанию, нажмите
По умолчанию.

Чтобы вернуться назад к основному виду (отображаются все категории), нажмите
Назад в верхнем левом углу окна. Вы так же можете найти нужную категорию
введя название одного из ее элементов в поисковое поле в верхней части окна
(например, Хранитель экрана). Каждый введенный Вами символ в строке Поиск
улучшает точность поиска.

Для более удобного представления всех категорий, Вы можете переключиться на
их вывод в виде дерева, нажав Настроить и выбрав другой Вид меню.

5 Применение эффектов рабочего стола
Если Ваш компьютер оснащен видео картой поддерживающей ускорение 3D-
графики и Xgl, то Вы можете использовать такие графические эффекты как
превращение рабочего стола во вращаемый трехмерный куб, прозрачные
элементы рабочего стола или прозрачные окна, экранная лупа и так далее. Вы
так же можете использовать другие эффекты как тени, затухание и колыхание
окон. Если у Вас нет совместимой видео карты, некоторые эффекты могут быть
заблокированы или негативно сказаться на производительности Вашей системы.
Если производительность Вашего компьютера очень маленькая - отключите
композитные эффекты для Вашей текущей сессии с помощью [Alt] + [Shift] + [F12].

Чтобы настроить эффекты рабочего стола, проделайте следующее:

1 Запустите Параметры системы как описано в Раздел 4.3, «Изменение
персональных настроек» (стр. 18).
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2 Выберите Эффекты рабочего стола в категории Внешний вид и поведение
рабочего стола и отметьте Включить графические эффекты. Если Ваша
видео карта не поддерживает ускорение 3D графики, то Вы получите
соответствующее уведомление.

3 Дополнительно, можно изменить некоторые настройки в секции Основные
параметры.

4 На вкладке Эффекты выберите необходимые Вам эффекты. Нажмите на
значок с буквой i, чтобы получить краткое описание для соответствующего
эффекта. Если эффект активирован, то значок с гаечным ключом
предоставит доступ к таким настройкам, например как, сочетания клавиш.

5 Воспользуйтесь кнопкой Применить, чтобы немедленно активировать
выбранные эффекты.

6 Использование виртуальных рабочих столов

Среда рабочего стола предоставляет возможность размещать Ваши программы
и задачи на нескольких виртуальных рабочих столах. Если Вы часто работаете с
множеством запущенных программ, то данная функция позволит сократить число
окон выводимых на экран. Вы могли бы, например, использовать один рабочий
стол для работы с электронной почтой и календарем, а другой для правки текстов
и обработки изображений.

Процедура 7 Перемещение приложения на другой виртуальный рабочий стол

Вы можете отобразить запущенные приложения с текущего или со всех
виртуальных рабочих столов, или перемещать их на другие рабочие столы.

1 Запустите любое приложение.

2 Нажмите правой кнопкой мыши на заголовке окна.

3 Нажмите На рабочий стол.

4 Выберите рабочий стол на который нужно переместить приложение.

5 Чтобы переключиться на другой рабочий стол выберите нужный в
виджете Переключение рабочих столов. Переключаться на следующий
или предыдущий рабочий стол можно с помощью колеса мыши, поместив
курсор над пустым пространством рабочего стола.

Процедура 8 Конфигурирование виртуальных рабочих столов

Вы можете увеличить число виртуальных рабочих столов, изменить
присвоенные им по умолчанию названия, назначить комнаты, настроить
эффекты анимации или назначить сочетания клавиш для их переключения.
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1 Чтобы добавить еще один рабочий стол нажмите правой кнопкой мыши
на пейджере и выберите Добавить виртуальный рабочий стол. Новый
рабочий стол появится в этом виджете.

2 Для получения доступа к настройкам нажмите правой кнопкой мыши на
пейджере и выберите Настроить виджет "Переключение рабочих столов".

3 Используйте настройки в секции Параметры для задания внешнего вида
и поведения виджета.

4 Названия рабочих столов, сочетания клавиш и анимация переключения
между виртуальными рабочими столами могут быть настроены в секции
Рабочие столы.

5 Установите настройки в соответствии с Вашими предпочтениями и
нажмите OK, чтобы применить сделанные изменения и закрыть это
диалоговое окно.

7 Работа с файловым менеджером
В KDE 4, Dolphin заменил Konqueror в качестве программы по умолчанию
для работы с файлами. Konqueror остался веб-браузером (смотрите Раздел 8,
«Путешествие в сети Интернет» (стр. 25)). Чтобы запустить Dolphin выберите
в главном меню Избранное > Менеджер файлов или нажмите [Alt] + [F2] и введите
dolphin.

7.1 Dolphin, основное окно

Основное окно Dolphin состоит из следующих элементов:
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Строка меню:  Строка меню содержит элементы для таких действий
как: копирование, перемещение и удаление файлов, изменение режима
представления, запуск дополнительных инструментов, различных настроек и
получения помощи.

Панель инструментов:  Панель инструментов обеспечивает быстрый доступ к
часто используемым функциям, которые также доступны через меню. Если Вы
подведете курсор мыши к значку, то увидите краткое описание во всплывающей
подсказке.

Строка адреса:  Строка адреса отображает путь к текущему открытому каталогу.
Она может быть представлена в двух версиях: путь до текущего каталога
отображается значками для каждой встречающейся папки в виде «хлебных
крошек». Нажмите на любой значок в строке адреса, чтобы перейти в этот
каталог. Вторая версия показывает путь до текущего каталога в виде текстовой
строки, которую Вы можете редактировать.

Панели:  По умолчанию, Dolphin отображает только панель Точки входа. Она
предоставляет быстрый доступ к часто используемым местам, например как,
Ваш домашний каталог, корневой каталог (/ ), корзина и внешние носители. Есть
и другие панели, которые Вы можете добавить в основное окно нажав Вид >
Панели.

Область отображения (рабочее пространство):  В области отображения
выводится содержимое выбранного каталога или файла. По умолчанию, при
запуске Dolphin отображает содержимое Вашего домашнего каталога. Нажатие
на папку или файл в Dolphin приведет к следующему: он загрузит файл в
приложение для дальнейшей обработки или отобразит содержимое этой папки.

Строка состояния:  Отображает тип и размер выделенного объекта, позволяет
увеличить или уменьшить размер значков или записей, отображаемых в рабочем
пространстве.
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7.2 Управление файлами и папками в Dolphin

Чтобы выполнить такие действия как копирование, перемещение, создание или
удаление файлов Вы должны обладать соответствующими правами доступа для
этих каталогов и файлов.

Для копирования, перемещения или удаления файла или каталога, проделайте
следующее:

1 Чтобы выбрать в Dolphin один или несколько файлов или каталогов
переместите указатель мыши к значку, но не нажимайте на него. Появится
зеленый значок плюса в верхнем левом углу. Если Вы нажмете на него, то
этот элемент будет выделен. Чтобы снять выделение нажмите на красный
значок минуса наведя курсор на выделенный объект.

Другим способом можно выделить или снять выделение у нужных
объектов зажав [Ctrl] при выделении элементов мышью.

2 Нажмите правой кнопкой мыши и выберите Копировать или Вырезать в
появившемся контекстном меню.

3 Перейдите в в нужный каталог и вставьте туда выбранные элементы.

4 Чтобы создать новую папку в текущем каталоге, выберите Файл >
Создать > Папку или нажмите [F10]. Укажите имя для нового каталога в
появившемся окне и нажмите [Enter].

5 Чтобы вставить скопированные или вырезанные объекты на шаге Шаг 2
(стр. 23), нажмите правой кнопкой мыши находясь в каталоге, в который
Вы хотите вставить объекты и выберите Вставить. Выбранные объекты
будут скопированы или перемещены в эту папку.

6 Чтобы удалить файл или папку, нажмите правой кнопкой мыши на
удаляемом объекте и выберите Удалить в корзину в появившемся
контекстном меню. Выбранный объект будет перемещен в корзину. В ней
Вы сможете восстановить удаленный по ошибке объект или окончательно
удалить его без возможности восстановления.

Чтобы быстро отфильтровать файлы в текущем каталоге по имени, нажмите
[Ctrl] + [I] – появится поле ввода Фильтр в низу основного окна Dolphin. Введите
любую часть имени файла, который Вы ищете, чтобы отобразились все файлы
в текущем каталоге, в имени которых присутствует заданная строка. Для более
детального и расширенного поиска, нажмите [Ctrl] + [F], чтобы запустить утилиту
KFind. Для получения дополнительной информации, обратитесь к Раздел 14.2,
«Использование локального поиска Strigi» (стр. 35).

7.3 Настройка Dolphin

Dolphin предлагает много опций для изменения представления данных о файлах
и всех других параметров в соответствии с Вашими предпочтениям.
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Процедура 9 Смена представления

1 Чтобы переключить адресную строку из вида хлебных крошек к
редактируемой версии, нажмите [F6] или нажмите на фон хлебных крошек.
Введите путь до нужного каталога. После ввода адреса нажмите [Enter].

Чтобы очистить содержимое адресной строки нажмите на черный символ
X справа. Чтобы переключиться обратно к виду хлебных крошек нажмите
[Ctrl] + [L].

2 Чтобы изменить представление текущей папки нажмите на панели
инструментов на Значки, Таблица или Столбцы. Dolphin запомнит
выбранный вид для текущей папки. Нажмите Две панели или [F3],
чтобы представить содержимое текущей папки в двух разделенных
столбцах. Теперь Вы можете перемещаться по каталогам в каждом
столбце и легко перетаскивать объекты из одно столбца в другой или
сравнивать содержимое каталогов. Нажмите еще раз [F3], чтобы убрать
дополнительный столбец.

3 Чтобы указать Dolphin отображать также и скрытые файлы, выберите Вид
> Показывать скрытые файлы.

4 Чтобы выводить больше информации о файлах (как права доступа
или владельца) в рабочем пространстве окна, выберите Вид >
Дополнительные сведения и отметьте интересующие Вас опции.

5 Чтобы добавить нужные каталоги на панель Точки входа, перетащите
папку из рабочей области на эту панель. Нажмите правой кнопкой мыши
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и воспользуйтесь контекстным меню, чтобы скрыть, отредактировать или
удалить элементы панели Точки входа.

6 Чтобы добавить другие панели в главном окне, выберите Вид > Панели
и выберите такие дополнительные панели как Сведения, Папки или
Терминал.

Открепить панели от главного окна Dolphin можно нажав на левый значок в
заголовке каждой панели. Нажмите на заголовок панели и потяните ее в любое
другое место на рабочем столе. Чтобы вернуть панель обратно в окно Dolphin,
снова нажмите на левый символ в заголовке панели.

Процедура 10 Полное изменение настроек Dolphin

Если Вы хотите полностью изменить поведение Dolphin или его внешний вид,
выберите Настройка > Настроить Dolphin... и изучите опции, предлагаемые в
диалоге настройки Dolphin.

1 Чтобы использовать один режим представления для всех папок, нажмите
Главное в левом столбце. Выберите Одинаковые для всех папок
на вкладке Представление. Измените опции режимов представления
согласно вашим предпочтениям на других вкладках и нажмите Применить,
чтобы сохранить изменения.

2 Если Вы хотите, чтобы Dolphin отображал другой каталог при запуске или,
если Вы хотите всегда использовать строку адреса в текстовом формате
вместо хлебных крошек, то измените соответствующие опции выбрав
слева Начальное представление.

3 Чтобы настроить пункты и действия отображаемые в контекстном меню
Dolphin нажмите Главное. На вкладке Контекстное меню активируйте
необходимые пункты. Нажмите Действия в левой панели и включите или
отключите соответствующие действия для контекстного меню.

4 Нажмите OK, чтобы сохранить изменения и закрыть диалог настройки
Dolphin.

8 Путешествие в сети Интернет

Кроме Konqueror (веб-браузер по умолчанию в KDE), openSUSE также включает
брайзер Firefox. Чтобы запустить Konqueror или Firefox нажмите [Alt] + [F2] и
введите, соответственно, konqueror или firefox.

В купе с такими функциями как поддержка вкладок, блокирование всплывающей
рекламы и менеджер загрузок, оба браузера сочетают в себе последние
достижения в веб-технологиях. Их свободный подход к использованию поисковых
механизмов помогает Вам находить информацию, в которой Вы нуждаетесь.
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Введите URL в адресной строке, чтобы перейти по этой ссылке. Чтобы открыть
новую пустую вкладку нажмите [Ctrl] + [T]. Чтобы открыть ссылку в новой вкладке
нажмите на ней средней кнопкой. Нажмите правой кнопкой мыши на вкладке,
чтобы обратиться к большому количеству опций доступных для вкладок. Вы
можете создать новую вкладку, перезагрузить или закрыть одну или все открытые
вкладки. Вы можете также изменить расположение вкладок перетаскивая их в
нужное положение.

8.1 Поиск информации

Оба браузера предлагают различные параметры поиска: Вы можете искать
информацию в Интернет или по ключевому слову в тексте открытой страницы.

Процедура 11 Поиск в Интернет

1 Чтобы запустить поиск в Интернет нажмите на значок в левой части
поисковой строки, для открытия списка доступных поисковых ресурсов.

2 Выберите желаемый поисковый ресурс и введите поисковый запрос в
текстовое поле.

3 Нажмите [Enter], чтобы запустить поиск.

4 Чтобы найти искомое слово на открой странице в Firefox или Konqueror
нажмите [Ctrl] + [F], чтобы открыть панель поиска в нижней части окна.
Введите здесь слово которое необходимо найти и используйте кнопки на
панели, чтобы искать в разных направлениях или установить настройки
поиска, например как, С учетом регистра.

Konqueror предлагает пользователям сокращения для быстро поиска в Интернет.
Например, чтобы запустить поиск для слова yast используя Google, просто
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введите gg: yast в адресной строке браузера (или диалоге Выполнить команду)
и нажмите [Enter].

Вы можете задать собственные сокращения в Konqueror и Firefox как описано в
Раздел 8.3, «Задание персональных настроек» (стр. 27).

8.2 Загрузка файлов из сети

Если Вы попробуете загрузить файл в Firefox или Konqueror, то увидите
диалоговое окно запрашивающее у Вас разрешение на сохранение или открытие
файла в программе связанной с этим типом файлов. Так же можно указать
применять выбранное действие ко всем файлам данного типа. По умолчанию,
Firefox сохраняет файлы в папку заданную в Настройках Firefox и показывает
завершенные загрузки в диалоговом окне Загрузки.

Чтобы открыть загруженные файлы, нажмите правой кнопкой мыши и выберите
Открыть. Чтобы очистить историю загрузок, нажмите правой кнопкой мышки и
выберите Очистить список.

8.3 Задание персональных настроек

Установите желаемое поведение Konqueror или Firefox. В Konqueror, получить
доступ к диалогу настроек можно в Настройка > Настроить Konqueror....
Чтобы изменить поведение Konqueror как Веб-браузера, выберите категорию
Веб-браузер в левой панели, чтобы отобразить опции для соответствующей
категории. Например, Вы можете «спрятать» реальный идентификатор
Konqueror и задать для него значение для другого браузера (например, Internet
Explorer*) определенных сайтов. Для этого выберите Версия браузера и нажмите
Добавить, чтобы добавить идентификацию для нужного домена.

Вы можете задать сетевые сокращения, которые используете в Konqueror
(или в диалоге Выполнить команду). В диалоге настройки Konqueror нажмите
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Сокращения, чтобы увидеть какие сокращения уже определены. Нажмите
Добавить , чтобы задать новое сокращение. Закройте диалог настройки
Konqueror нажатием на OK, чтобы сохранить изменения.

В Firefox, выберите Правка > Настройки, чтобы открыть Настройки Firefox.
Нажмите на значок в верхней части экрана, чтобы получить доступ к
настройкам в соответствующей нужной категории. Например, измените папку
загрузок по умолчанию на вкладке Основные или скорректируйте правила
блокирования всплывающих окон на странице Содержимое. Нажмите Закрыть,
чтобы сохранить сделанные изменения.

Чтобы настроить веб-сокращение для быстрого поиска в Firefox перейдите на
страницу с нужным поисковым полем. Нажмите правой кнопкой мыши на этом
поле и выберите Добавить краткое имя для данного поиска.... Укажите Краткое
имя и покиньте этот диалог нажав на Сохранить.

9 Управление паролями
Когда Вы впервые вводите пароль в приложении KDE (например, в KMail или
Konqueror), Вам будет задан предложено сохранить пароль в зашифрованном
бумажнике. Если Вы нажмете Да, то по умолчанию запустится мастер KWallet.
KWallet – это приложение для управления паролями, в котором Вы можете
хранить все свои пароли в надежно зашифрованных файлах (бумажниках).

Для активации KWallet выберите Стандартная настройка и нажмите Далее.
Выберите Да, я хочу использовать бумажник KDE для хранения личной
информации и введите пароль. Это Ваш мастер-пароль для получения доступа к
бумажнику (с названием kdewallet), который будет создан на следующем шаге.

ВНИМАНИЕ: Зашита Ваших паролей в KWallet

Если Вы забудете мастер-пароль для какого-либо бумажника, то его будет
невозможно восстановить. Кроме того, любой, кто знает Ваш мастер-пароль
может получить доступ ко всей информации содержащейся в этом бумажнике.
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Нажмите Завершить, чтобы завершить настройку. Если Вы запустите мастер
KWallet из другого приложения как, например, Konqueror или KMail, то KWallet
запросит у Вам мастер-пароль для бумажника, чтобы сохранить в нем пароль
для этого приложения. После создания конфигурации Вы можете окткрыть
Ваш бумажник в любое время для просмотра, поиска, удаления или создания
записей. Обычно добавлять записи вручную не нужно. KDE самостоятельно
распознает когда ресурсу необходима авторизация и автоматически запустит
KWallet, при этот у Вас будет запрошен мастер-пароль. Тем не менее, Вы можете
добавить дополнительные данные, если это необходимо. Для на настройки
каких-либо парамтеров KWallet намжите [Alt] + [F2] и введите kwalletmanager.
В открывшейся программе управления бумажниками KDE выберите Настройка
> Настроить KWallet....

Не смотря на то, что KWallet создавался как основная программа для управления
паролями KDE приложений, Firefox так же может хранить данные которые
Вы вводите в поля имени пользователя и пароля на Веб-сайтах. Если Вы
подтвердите свое согласие на сохранение этих данну нажатием на кнопку
Запомнить, то пароль будет сохранен на Вашем жестком диске в зашифрованном
формате. В следующий раз, когда Вы посетите этот сайт Firefox автоматически
заполнит поля имени пользователя и пароля.

Firefox не использует KWallet для хранения паролей – используется
собственное хранилище паролей. Чтобы просмотреть или изменить Вами пароли
сохраненные в Firefox нажмите Правка > Настройки > Защита > Сохраненные
пароли....

10 Электронная почта и календарь

Для чтения и управления Вашей почтой, Вы можете воспользоваться программой
Kontact, выступающей в качетсве персонального информационного менеджером
(Personal Information Manager, PIM). Kontact объединяет в едином интерфейсе
такие приложения из состава KDE как KMail, KOrganizer и KAddressBook.
Это позволяет легко получить доступ к почте, календарю, адресной книге и
другим функциям PIM. Kontact так же поддерживает работу сразу с несколькими
учётными записями электронной почты.

10.1 Первый запуск Kontact

Чтобы запустить Kontact нажмите [Alt] + [F2] и введите kontact. Чтобы доступ к
одному из его компонентов, как, например, KMail нажмите на соответствующий
значок в левой боковой панели.
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Перед тем, как Вы сможете отправить или получить почту необходимо настроить
учётную запись:

1 В меню выберите Настройка > Настроить Kontact....

2 В левой боковой панели под Почта нажмите на Профили и выберите
профиль автоматически созданный KMail. Нажав Изменить... можно
указать Ваше полное имя и адрес электронной почты, внести другие
изменения.

3 Нажмите Учётные записи в левой боковой панели под Почта и
Добавить..., чтобы добавить по крайней мере по одной учётной записи на
вкладках Получение и Отправка. (Вы можете настроить одновременное
использование нескольких учётных записей).

Обычно, требуется следующая информация для обоих учётных записей –
для входящей и отправляемой почты: тип учётной записи, адрес сервера
и порт. В зависимости от учётной записи, Вам так же понадобится указать
опции шифрования или авторизации. Если Вы не уверены, что знаете
какие настройки нужно указать – обратитесь за консультацией к Вашему
Интернет-провайдеру или системному администратору.

4 Проверьте установки и покиньте диалог настройки нажав OK.

Чтобы написать письмо нажмите на значок Почтка в главном окне Kontact
и нажмите [Ctrl] + [N]. После того, как Вы закончите написание письма
нажмите Отправить, чтобы немедленно его отправить. В случае использования
нескольких учётных записей нажмите удерживайте кнопку Отправить нажатой,
чтобы выбрать учётную запись с помощью которой Вы хотите отпарвить это
письмо.
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11 Обмен мгновенными сообщениями в Kopete

Kopete – приложение для обмена сообщениями в сети Интернет, позволяющее
работать сразу с несколькими протоколами. Kopete в настоящее время
поддерживает все популярные протоколы общения, такие как AOL* Instant
Messenger (AIM), Gadu-Gadu, GroupWise® Messenger, ICQ, Jabber*, MSN, SMS и
Yahoo!*. Чтобы воспользоваться службой мгновенного обмена сообщений (IM),
Вы должны сначала зарегистрироваться у провайдера предлагающего данную
службу IM, и настроить учётную записать в Kopete.

Чтобы запустить Kopete нажмите [Alt] + [F2] и введите kopete. Если программа
запущена первый раз – нажмите на значок гаечного ключа в нижней части
окна Kopete, чтобы создать учетную запись. Kopete проведет Вас через
несколько шагов как выбор службы обмена сообщениями, ввод соответствующей
информации об учётной записи – имя пользователя или ID, имя сервера
и порт и другие данные необходимые для авторизации. Если Вы еще не
зарегистрированы в выбранной службе обмена сообщениями, то нажмите
Зарегистрировать новую учетную запись. В открывшемся окне браузера введите
данные необходимые для регистрации. Переключитесь обратно в Kopete и
введите данные полученные при регистрации. Для завершения настройки
учетной записи нажмите Завершить.

Если Вы решили выйти в сеть после конфигурирования Вашей учетной записи,
то Вы можете добавить контакты в основном окне Kopete. Если в окне Kopete
отображается статус не в сети, сперва нажмите Файл > Установить статус >
В сети и введите пароль, если он будет запрошен. После подключения нажмите
Файл > Добавить контакт и выберите учётную запись Kopete для которой Вы
хотите добавить контакты. Введите данные кантакта или найдите его и нажмите
OK.

Чтобы видеть все Ваши контакты, даже если некоторые из них не в сети,
выберите Настройка > Показывать пользователей не в сети.

Чтобы начать с кем-нибудь разговор, нажмите на нужном контакте и введите
сообщение в нижней части открывшегося окна. Нажмите [Enter] для отправки
сообщения. В верхней части окна будет отображаться Ваша переписка.
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12 Запуск LibreOffice
Набор офисных приложений LibreOffice включает все необходимое для работы:
текстовый процессор, редактор электронных таблиц, мастер презентаций,
редактор векторной графики и компоненты для работы с базами данных. Так как
LibreOffice доступен для большого числа систем – Вы можете работать с теми же
данными на различных компьютерных платформах.

Чтобы запустить LibreOffice нажмите [Alt] + [F2] и введите ooffice. В
открывшемся окне выберите модуль LibreOffice который Вы хотите запустить.
Чтобы создать новый документ выберите Файл > Создать и выберите тип
создаваемого документа. Чтобы открыть существующий документ выберите
Открыть и укажите соотвуствующий файл в файловой системе.

13 Просмотр PDF-файлов и других документов
Документы, которые должны быть доступны для распространения или печати на
многих платформах, могут быть сохранены в формате PDF (Portable Document
Format), например, при помощи LibreOffice. Просмотреть их можно с помощью
Okular – программа по умолчанию для просмотра документов в KDE.

13.1 Использование Okular

Кроме файлов формата PDF Okular позволяет просматривать большое число
других форматов, таких как PostScript, несколько форматов изображений,
формат OpenDocument (ODF), OpenDocument Text (ODT), некоторые форматы
eBook (ePub), и даже Microsoft* Compiled HTML Help (CHM). Также
Okular поддерживает работу с закладками, аннотациями, метаданным и
мультимедийным содержимым, а также поворот страниц.

Запустить Okular можно из Главного меню или нажав [Alt] + [F2] и введя okular.



KDE Быстрый старт  33

Чтобы открыть документ, выберите Файл > Открыть и укажите нужный файл
в файловой системе. Перемещение по документу, осуществляется с помощью
значков навигации в верхней или нижней части окна. В зависимости от значка
на который Вы нажмете, расположенных в левой части окна, в боковой панели
отобразится колонка с Содержанием, Миниатюрами для каждой страницы,
Рецензирование или Ваши Закладки для этого документа. Чтобы найти любой
текст среди перечисленных в боковой панели миниатюр или во всем документе,
просто введите искомую строку в поле вверху боковой панели. Если Вам нужно
выделить и скопировать текст или изображение из открытого в Okular файла,
то нажмите на значок Выделение области на панели инструментов и выберите
нужную функцию в контекстном меню. Нажмите на значок Перетаскивание, чтобы
переключиться обратно в режим просмотра документа.

Процедура 12 Работа с закладками и аннотациями

С Okular Вы можете рецензировать документ, подсвечивая части текста, или
добавлять примечания или закладки, которые Okular затем прикрепит к файлу в
виде метаданных. Заметьте, что добавленные Вами примечания и закладки не
сохранятся в документе, поэтому Вы не сможете их распечатать или передать
другим пользователям.

1 Чтобы добавить закладку для страницы в боковой панели или в главном
окне приложения нажмите [Ctrl] + [B]. Страница будет добавлена в
список Закладок, доступный на левой боковой панели. Нажав правой
кнопкой мыши на закладке в появившемся контекстном меню ее можно
переместить, переименовать, или удалить.

2 Чтобы создать примечание для страницы нажмите [F6] и выберите один из
инструментов рецензирования в появившейся панели. Примечание будет
добвалено в список Рецензирование с указанием имени пользователя
создавшего его. Используйте значок в нижней части боковой панели для
группировки примечаний по страницам, по авторам или, чтобы отобразить
примечания только для текущей страницы.
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3 Чтобы открыть вспылвающее окно и добавить текст в примечание
(или удалить примечание), нажмите правой кнопкой мыши по
примечанию в списке Рецензирование и выберите соответствующий пункт
меню. Примечание или выделение, добавленные Вами, автоматически
присоединяются к файду, поэтому нет необходимости сохранять их.

13.2 Использование Acrobat Reader

Если Acrobat Reader не установлен по умолчанию – установите пакет acroread
с помощью YaST. Чтобы запустить Acrobat Reader нажмите [Alt] + [F2] и введите
acroread. Нажмите Файл > Открыть, выберите нужный PDF-файл и нажмите
Открыть, чтобы увидеть содержимое этого файла.

14 Поиск данных
KDE предлагает множество приложений для осуществления поиска данных
на Вашем компьютере или в файловой системе. Одним из таких приложений
является KFind, работа с которой описывается ниже.

14.1 Использование KFind

Чтобы воспользоваться простым и расширенным поиском, используйте KFind.
Запустить эту программу можно из Главного меню, выбрав Приложения > Поиск
файлов и папок или нажав [Alt] + [F2] и введя kfind.

Процедура 13 Поиск по имени

Чтобы использовать имя файла (или его часть) как поисковый запрос,
выполните следующее:

1 Введите имя файла или только его часть в поле Имя файла.
Используйте специальные символы, такие как звездочка (*), чтобы указать
недостающие символы в имени файла.

2 Укажите папку в которой необходимо произвести поиск файла. Также
можно ввести путь до нужной папки в поле Искать в или нажав Просмотр...,
чтобы указать расположение папки.

3 Для поиска в подкаталогах, отметьте Включая вложенные папки.

4 Нажмите Поиск, чтобы начать поиск. Результаты поиска отобразятся в
нижней части диалогового окна. Чтобы открыть найденную папку, просто
нажмите на нее. По нажатию правой кнопки мыши можно выбрать одну из
функций контекстного меню.

Процедура 14 Поиск по содержимому и свойствам файла

Для более детального поиска, Вы можете задать дополнительные опции, такие
как текст, который должен содержать файл, или время последнего изменения
файла. Для поиска по содержимому или свойствам выполните:
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1 На вкладке Имя и расположениеn определите путь, где следует искать
файл. Поле Имя файла можно оставить пустым.

2 Чтобы найти определенное содержимое в файле, перейдите на вкладку
Содержимое. В поле Содержит текст, введите слово или фразу, которую
требуется найти. Эта функция работает не для всех типов файлов.

3 Для поиска по свойствам, таким как время создания или время
последнего изменения файла, перейдите на вкладку Свойства и выберите
необходимые опции.

4 Нажмите Поиск, чтобы начать поиск.

14.2 Использование локального поиска Strigi

Демон локального поиска Strigi предоставляет возможность расширенного
поиска с учетом таких метаданных как теги, оценки и даже URL-источник загрузи.
Для этого потребуется запустить службы nepomuk и strigi. Для активации
этих служб ажмите [Alt] + [F2] и введите strigi. Выберите Настройка сервера
Nepomuk/Strigi, чтобы открыть окно настройки. Включите две службы на вкладке
Основные параметры и закройте это окно нажав Применить и OK.

После активирования этих служб Вы можете использовать KRunner ([Alt] + [F2])
для поиска файлов только вводя ключевые слова. Интерфейс расширенного
поиска доступен в файловом менеджере Dolphin. Намжите в Dolphin [Ctrl] + [F] для
активации локального поиска. Вы можете задать фильтр для результатов поиска:
Имена файлов, Содержимое или расположение.

15 Создание CD или DVD
Если Вы являетесь обладателем CD или DVD привода с поддержкой записи, то
Вы можете записывать файлы на CD или DVD при помощи K3b. Чтобы записать
данные на диск, выполните следующее:
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1 Нажмите [Alt] + [F2] и введите k3b. Откроется программа K3b.

2 Выберите Файл > Создать проект > Новый проект с данными из главного
меню.

3 Используйте дерево просмотра в левой части окна для поиска файлов или
папок, которые Вы хотите записать на диск. Когда они появятся в верхней
правой части окна, перетащите их в окно Текущие проекты.

4 Вставьте записываемый диск в устройство и нажмите на Записать.

5 Проверьте настройки на вкладке Запись. Обычно не нужно вносить какие-
либо изменения. Если желаете, можете изменить информацию о проекте
на вкладке Файловая система.

6 Намжите Записать.

16 Управление Вашей коллекцией цифровых
изображений
С digiKam очень просто управлять Вашими цифровыми изображениями:
загружать их с камеры, править и улучшать, объединять в альбомы (или
создавать метки для простого поиска независимо от папок или альбомов), и
архивировать их на CD, или экспортировать в Веб-галерею.

digiKam также содержит ряд полезных функций и дополнений, которые позволят
Вам преобразовывать многочисленные изображения в различные форматы,
переименовывать сразу множество изображений, или автоматически улучшать
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их с помощью специальных функций, таких как удаление эффекта "красных
глаз", шумоподавление и удаление "горячих" пикселей. Различные фильтры и
дополнения к программе позволят создавать произведения искусства из Ваших
фотографий.

Чтобы запустить digiKam нажмите [Alt] + [F2] и введите digikam. При первом
запуске появляется мастер первоначальной настройки, в котором будет задать
некоторые настройки.

Главное окно digiKam содержит древовидное представление Вашей коллекции
в левой части окна и отображает миниатюры изображений в правой части. Для
быстрого доступа к Вашим изображениям используйте боковую панель слева, с
помощью которой можно переключаться между различными видами, например,
сортировать изображения по Альбомам, Дате, Меткам или Поисковым запросам.
Чтобы переключить digiKam в режим просмотра или редактирования нажмите
два раза по миниатюре.

17 Управление Вашей музыкальной коллекцией

Аудиоплейер KDE Amarok позволяет Вам прослушивать различные звуковые
форматы, создавать списки воспроизведения, слушать потоковое вещание
радиостанций в Интернете и подписываться на подкасты. Поддерживаемые типы
файлов зависят от механизма, используемого в Amarok.

Для запуска Amarok нажмите [Alt] + [F2] и введите amarok. При первом запустке
Amarok попросит указать каталог, в которрм находятся аудио файлы.
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В главном окне Amarok присутствует боковая панель в левой его части,
с помощью которой можно переключаться между различными видами:
музыкальной коллекцией, адресами для прослушивания подкастов или
потокового радиовещания в Интернет, списками воспроизведения и файловым
навигатором. В средней части, контекстном навигаторе, отображается
информация о текущей дорожке, сведения об артисте и текст песни из
Википедии. Правая часть окна отображает текущий список воспроизведения.
Чтобы запустить воспроизведение музыки достаточно перетащить элементы из
любой боковой панели в список воспроизведения. Двойное нажатие на элементе
в списке воспроизведения запускает его воспроизведение.

Если Ваши музыкальные файлы содержат корректные метаданные (по
крайней мере содержат информацию об артисте и альбоме), то Вы можете
воспользоваться несколькими замечательными возможностями Amarok. Чтобы
автоматически получать изображение обложки диска с Amazon, выберите Сервис
> Управление обложками и нажмите Загрузить недостающие обложки. При
следующем воспроизведении песни из этого альбома, обложка отобразится в
контекстном навигаторе и в экранном уведомлении. Чтобы узнать больше об
артисте нажмите на кнопку Википедия в средней части окна, чтобы Amarok
выполнил поиск подходящей статьи в Википедии.

Чтобы настроить любой другой механизм (или других функций Amarok), выберите
Настройка > Настроить Amarok....

18 Выход из системы

Выход из системы (без завершения работы системы), перезагрузка или
выключение компьютера.
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18.1 Завершение сеанса или переключение пользователя

Нажмите на значок Главное меню на панели и выберите Выход > Завершить
сеанс KDE. Сеанс завершится, но система продолжит свою работу. Чтобы
запустить параллельный сеанс с другим пользователем выберите Выход >
Переключить пользователя.

18.2 Перезагрузка или выключение компьютера

Нажмите Выход, затем выберите один из следующих вариантов:

Ждущий режим
Доступно только, если Ваш компьютер поддерживает функции управления
питанием. Приостанавливает работу компьютера без завершения сессии. Все
Ваши данные и данные сессии сохранаяются в оперативной памяти (RAM).

Спящий режим
Доступно только, если Ваш компьютер поддерживает функции управления
питанием. Приостанавливает работу компьютера без завершения сессии.
Все Ваши данные и данные сессии сохранаяются на диске до выключения
компьютера. Таким образом Вы будете защищены от потери данных даже,
если питание компьютератем будет отключено.

Перезагрузить
Перезапускает Ваш компьютер.

Выключить
Закрывает текущий сеанс, затем выключает компьютер.

19 Дополнительная информация
Дополнительную информацию о KDE и приложениях KDE смотрите на http://
www.kde.org/  и http://www.kde-apps.org/ .

http://www.kde.org/
http://www.kde.org/
http://www.kde-apps.org/
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openSUSE® provides the tools that Linux* users require in their daily activities.
It comes with an easy-to-use graphical environment, the GNOME* desktop, that
communicates with the underlying Linux system, to let you access and manage files,
folders, and programs. openSUSE provides an integrated suite of applications for a
wide range of office, multimedia, and Internet activities. The LibreOffice suite, which
allows you to edit and save files in a number of formats, is also included. The office
suite is available for several operating systems. Therefore, you can use the same data
across different computing platforms.

1 Getting Started

When you start your system, you are usually prompted to enter your username and
password. If someone else installed your system, check with your system administrator
for your username and password.

After logging in to GNOME for the first time, you see the GNOME desktop, offering the
following basic elements:
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Desktop Icons:  Access programs and features on your system by double-clicking an
icon. Right-click an icon to get additional menus and options. By default, the desktop
features several key icons, including your personal Home folder and a trash can for
deleted items. Other icons representing devices on your computer, such as CD drives
or USB flash disks, may also be present on the desktop, and you can add as many
icons on your desktop as you like. If you double-click your Home folder, the Nautilus
file manager starts and displays the contents of your home directory.

Bottom Panel:  The desktop includes a panel at the bottom of the screen. This panel
contains the Computer menu, the Tomboy Notes applet, a taskbar to display buttons for
all currently running applications, and the system tray. You can also add applications
and applets to the panel for easy access.

Main Menu:  Click Computer on the left side of the bottom panel to open the main
menu. Commonly used applications appear in the main menu along with recently used
applications. Click the Documents button to display your recent documents, or click
the Places button to display your favorite places (such as your home directory, your
desktop, or available network servers). Click More Applications to access additional
applications, listed in categories. Use the options on the right to access help, open the
Центр управления GNOME, run YaST, install additional software, lock your screen,
log out of the desktop, shut down the system, or check the status of your hard drive
and network connections.

System Tray:  The right side of the bottom panel shows some smaller icons, including
the system clock that displays the current date and time, the Workspace Switcher, the
volume control, and icons for several other helper applications.

Taskbar:  By default, all applications running on the current desktop are displayed in
the taskbar (the area in the middle of the panel between the Computer button and the
system tray). You can access these applications by clicking their names in the taskbar.
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Right-click the application's name to see options for moving, restoring, or minimizing
the window.

Desktop Menu:  Right-click an empty spot on the desktop to display a menu with
various options. Click Create Folder to create a new folder on the desktop. Use
Create Launcher to create a launcher icon for an application. Provide the name of the
application and the command for starting it, then select an icon to represent it. You
can also change the desktop background, open a terminal, create a document, and
align desktop icons.

1.1 Modifying Desktop Panels

The bottom panel can be customized to meet your individual needs, and additional
panels can be added and configured to further personalize your desktop.

To add a new panel, right-click a blank space in the bottom panel and select New Panel.
To delete a panel, right-click a blank space in the panel and select Delete This Panel.
openSUSE requires that at least one panel is left on the desktop.

1.2 Adding and Removing Panel Icons

1 Right-click a blank space on the panel and select Add to Panel.

2 Browse to the desired program and double-click it to add it to the panel.

3 To remove a program icon from a panel, right-click its icon in the panel and
select Remove From Panel.

2 Starting Programs

Start programs from the Main Menu or from the command line, using a shell or the Run
Command. Additionally, you can start programs from the desktop or the panel by left-
clicking the program icon once.

2.1 Using the Main Menu

To run a program in openSUSE, click Computer on the panel to open the main menu
screen. If the program you want does not appear in the main menu screen, click More
Applications to view a list of all available applications grouped in categories. You can
also limit the list to show only applications with a specific name by entering all or part
of the name into the Filter field. Click an entry in the list to start the corresponding
program.
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You can also add an icon to your panel that opens a more traditional version of the
main menu. Right-click a blank space on the panel, select Add to Panel, then double-
click Traditional Main Menu.

If you already know the name of an application but are not sure how to start it from the
main menu, use the Search field in the main menu. Click Computer, type a portion of
the application name in the Search field, then press [Enter]. If the application is installed
on your system, the name of the application appears in the Needle  search dialog box.
Click the name to start the program.

2.2 Using the Run Application Dialog

Press [Alt] + [F2] to open the Run Application dialog. Type a command, for example,
f-spot, and press [Enter] or click Run to start the application. The command to start
the application is often (but not always) the application name written in lowercase.
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3 Handling Media
If you insert a CD or DVD into your drive or plug in a pluggable device (for example,
a USB stick or removable hard disk), GNOME opens Nautilus and shows the content
of the media.

4 Customizing Your Desktop
Easily add, delete, and create shortcut icons on your desktop. You can also change
icon properties and the desktop background to suit your needs.

4.1 Adding Program Icons to Your Desktop

1 Click Computer.

2 Browse to the desired program.

3 Click and drag the icon to the desktop and position it as desired.

To delete an icon from your desktop, simply click the program icon and press the
[Delete] key on your keyboard.

4.2 Changing the Desktop Background

1 Right-click the background.

2 Select Change Desktop Background.

3 To select a wallpaper from the pre-installed images, browse to and select the
desired image. After you select it, the background changes automatically.

4 To add an image, select Add, browse to the desired image, then click Open.
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5 To display a colored background, select the solid color rectangle from the top
of the list; then, from Colors, select the fill pattern and the desired colors.

6 Click Close.

4.3 Using the Центр управления GNOME

In addition to letting you change individual desktop elements, GNOME lets you
extensively personalize your desktop. You can find more settings to adjust the overall
appearance and behavior of your desktop in the Центр управления GNOME. There,
you can also change fonts, keyboard and mouse configurations, regional and language
settings, parameters for your Internet and network usage, and more.

To start the Control Center, click Computer, then click Control Center on the right of
the main menu.

5 Applying Desktop Effects

If your computer supports a 3D graphics card with Xgl, you can use graphical effects
like turning your desktop into a rotating 3D cube, enabling translucent or transparent
windows, and zooming in and out of the desktop screen. You can also use other window
effects such as shadows, fading, and transformations. If you do not have a 3D graphics
card, some effects may be disabled or reduce the performance of your system. If the
performance of your system is too low, disable the compositing effect for your current
session with [Alt] + [Shift] + [F12].
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To configure the effects on your desktop, proceed as follows:

1 Start the personal settings window as described in Section 4.3, “Using the
Центр управления GNOME” (page 46).

2 Select Look and Feel > Desktop Effects and choose Enable Desktop Effects. If
your graphic card does not support 3D, you will be notified.

3 Select the effects in one of the tabs.

6 Using Virtual Desktops
The desktop environment allows you to organize your programs and tasks on several
virtual desktops. If you often run a lot of programs simultaneously, this minimizes
the number of windows to arrange on your screen. You might, for example, use one
desktop for e-mailing and calendaring and another for word processing and graphics
applications.

Procedure 15 Moving an Application to Another Virtual Desktop

You can display a running application on one or all virtual desktops, or move it to
other desktops.

1 Open the application.

2 Right-click the title bar of the application.

3 Click Move to Another Workspace.

4 Select the desktop on which to place the application.
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5 To switch between desktops, click the desired desktop in the pager in the panel.

Procedure 16 Adding Additional Virtual Desktops

Some users might need more desktops than are provided by default. To add
additional desktops, do the following:

1 Right-click the pager in the panel and select Preferences. A configuration dialog
appears:

2 Decrease or increase the Number of Workspaces.

3 If you want to change the names of the desktops double click on the list entries
and enter the new names.

7 Managing Files and Folders

Use the Nautilus File Manager to create and view folders and documents, run scripts,
and create CDs of your data. To open Nautilus, double-click your home directory icon
on the desktop. You see the contents of your home directory.
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The elements of the Nautilus window include the following:

Menu  Lets you perform most tasks.

Toolbar  Lets you quickly navigate among files and folders, and provides access to
files and folders.

Location Bar  Lets you locate files, folders, and URI sites. If you prefer text based
location display to the button based one, select Go > Location.

Side Pane  Lets you navigate or display information about the selected file or folder.
Use the drop-down list to customize what is shown in the pane. The list includes ways
to view information about files, perform actions on files, attach emblems to files, view
a history of recently visited sites, and display your files in the tree system.

View Pane  Displays folders and files. Use the options on the View menu to increase or
decrease the size of content in the view pane and to display items as a list or as icons.

Status Bar  Displays the number of items in a folder and gives the available free space.
When a file is selected, the status bar displays the filename and size.

7.1 Archiving Folders

If you have files you have not used recently but want to keep on your computer, you
can compress the files into a tape archive (TAR) format.

1 In the Nautilus view pane, right-click the folder you want to archive and select
Compress.
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2 Accept the default archive filename or provide a new name.

3 Select a file extension from the drop-down list. Use tar.gz  for the most
common archive form. Use zip if you need to protect the archive with a
password.

4 Specify a location for the archive file, then click Create.

To extract an archived file, right-click the file and select Extract Here.

7.2 Using Bookmarks

Use the Nautilus bookmarks feature to mark your favorite folders.

1 Open the folder you want to create a bookmark for.

2 Click Bookmarks > Add Bookmark. The bookmark is added to the list, with the
folder name as the bookmark name.

3 To select an item from your bookmarks list, click Bookmarks, then click the
desired bookmark in the list.

You can also organize your bookmarks list by clicking Bookmarks > Edit Bookmarks
and making your selections in the dialog box.

To change the order of your bookmarks, click a bookmark shown in the Edit Bookmarks
dialog and drag it to the desired location.
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8 Browsing the Internet with Firefox

Firefox* is one of the most popular Web browsers. It has all the familiarity of other
browsers, plus added features such as security and privacy tools.

To start Firefox, click Computer > Firefox Web Browser.

With features like tabbed browsing, pop-up window blocking, and download and
image management, Firefox combines the latest Web technologies. Its easy access to
different search engines helps you find the information you need. Enter a URL in the
location bar to start browsing.

To open a new empty tab in Firefox, press [Ctrl] + [T] or the “+” button next to the last
tab . Type a new URL to browse. To open a link in a new tab, click the link with your
middle mouse button. Right-click a tab to access more tab options. You can create a
new tab, reload one or all existing tabs, or close a single tab or all tabs. You can also
change the sequence of the tabs by dragging and dropping them to a new position.

8.1 Finding Information

1 To start a search on the Web type your search keywords in the integrated search
box on the right of the location bar, then press [Enter]. The results are displayed
in the active window or tab.

2 To use a different search engine than the default, click the icon in the search
box to open a list of other search engines.

3 Click the desired engine, then press [Enter] to start the search.

To search the current Web page for words, press [Ctrl] + [F] to open the Find bar at
the bottom of the window. Enter your search keyword there and use the buttons to the
right of the box to search in different directions or to select all hits in the text.



52 Вступление

8.2 Downloading Files from the Web

If you download a file with Firefox, the Firefox download manager starts and saves this
file to the folder configured in Firefox Preferences. By default, the Downloads folder in
your home directory is the destination for downloaded files. Firefox shows your finished
downloads in the Downloads window.

Open the downloaded files directly from the Downloads window or from the destination
folder. To clean up the history of downloaded files, click Clean List.

8.3 Configuring Preferences

To adjust the default download folder or to activate or modify the pop-up blocking
feature, click Edit > Preferences.

Here also configure many other settings such as appearance, language, privacy, and
tab options. Click the icons and set the options on each page according to your
preferences. Click Close to apply the changes.

9 Managing Passwords
GNOME allows you to store your passwords and encryption keys in a keyring. This is
useful if you want to store passwords for different web sites.
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To create a new keyring, proceed as follows:

1 Press [Alt] + [F2] and enter seahorse.

2 Select File > New.

3 Choose Password Keyring and proceed with Continue.

4 Enter a name for your keyring. Then, a dialog box opens.

5 Enter your password, confirm the password, and click OK.

You can create as many keyrings as you like. For example, you can create one for
private and one for business. To store passwords in your keyring, proceed as follows:

1 Press [Alt] + [F2] and enter seahorse.

2 Select File > New.

3 Choose Stored Password and proceed with Continue.

4 Select your keyring, enter description and password.

5 Finish with Add.

10 E-Mailing and Calendaring
For reading and managing your mail and events, openSUSE offers you Evolution™, a
groupware program that makes it easy to store, organize, and retrieve your personal
information.

Evolution seamlessly combines an e-mail, a calendar, an address book, and a task
list in one easy-to-use application. With its extensive support for communications and
data interchange standards, Evolution can work with existing corporate networks and
applications, including Microsoft* Exchange.
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To start Evolution, click Computer > Evolution Mail and Calendar.

The first time you start it, Evolution prompts you with a few questions as it sets up a
mail account and helps you import mail from your old mail client. It shows you how
many new messages you have and lists upcoming appointments and tasks, as well as
the current weather and news from news feeds. The calendar, address book, and mail
tools are available in the shortcut bar on the left.

Press [Ctrl] + [N] to open a new item for whatever part of Evolution you are working in.
In mail, this creates a new message. If you are in the address book, [Ctrl] + [N] creates
a new contact card, and in the calendar, it creates a new appointment.

For more information on using Evolution, click Help > Contents in any Evolution
window.

11 Instant Messaging with Empathy

Empathy is a multiprotocol instant messaging (IM) client. It is compatible with AOL*
Instant Messenger (AIM), Google Talk, GroupWise® Messenger, ICQ, IRC, MSN
Messenger, Jabber/XMPP, Yahoo!*, and other networks.

With Empathy, you can log in to multiple accounts on multiple IM networks
simultaneously. Empathy also supports many features of the various networks, such
as video chat, file transfer, away messages, and typing notification.

To start Empathy, click Computer > More Applications > Internet > Empathy, or press
[Alt] + [F2] and enter empathy.

To add an account to Empathy, either use the initial configuration wizard, or select Edit
> Accounts. Click Add and select the protocol you want to use, and type your login
information in the appropriate fields. Click Log in to activate you IM account. Finally
click Close to start chatting with your friends.

Add contacts by clicking Chat > Add Contanct. Select account, identifier and alias
information relevant for the new contact and confirm with Add. However, you must be
online and connected to the selected messaging service to add a contact to your list.

To start a chat, double-click the desired contact and type your message in the lower
part of the chatting window. Press [Enter] to send the message. The upper part of the
window displays the messages you have sent and received.

12 Starting LibreOffice

The LibreOffice office suite offers a complete set of office tools, including word
processing, spreadsheet, presentation, vector drawing, and database components.
Because LibreOffice is available for a number of operating systems, you can use the
same data across multiple platforms.
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To start LibreOffice, click Computer > LibreOffice Writer. To create a new document,
click File > New, then choose the type of document you want to create. To open an
existing document, click Open, then select the file you want from the file system.

13 Viewing PDF Files and Other Documents

Documents that need to be shared or printed across platforms are often distributed as
PDF (Portable Document Format) files. PDF files can be created using the LibreOffice
suite or other applications. The GNOME PDF viewer is called Evince. It can be used
to view PDFs and many other document formats, like PostScript, DjVu, DVI, and multi-
page TIFFs.

To start Evince, press [Alt] + [F2] and enter evince .

1 To view a PDF file, double-click the PDF file.

2 Use the navigation icons at the top of the window to navigate through the
document. If the PDF document provides bookmarks, you can access them in
the left panel of the viewer.

14 Searching for Data

GNOME provides more than one application for finding data on your computer or in
the file system.

14.1 Using Desktop Search

To locate files or programs on your computer, click Computer. Enter a search term in
the Search field and press [Enter]. The results are displayed in the Needle.
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You can also start the Needle application by clicking Computer > More Applications >
Accessories > Desktop Search.

14.2 Using GNOME Do

GNOME Do describes itself as an “intelligent launcher that makes performing common
tasks on your computer simple and efficient.” It is extensible with plug-ins.

Start it by pressing [Super] + [Space]. The [Super] is normally located on the left and
right [Windows] or [Penguin] key.

GNOME Do allows you to perform specific actions. For example, if you type b, it
displays a starter button for the Banshee, the music player:

To customize GNOME Do to your needs, select the arrow button on the upper-right
corner of the window and select Preferences. It gives you a list of plug-ins to search
for mails in Evolution, listen to your music, etc.
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15 Creating a CD or DVD

If your system has a CD or DVD writer, use the Nautilus file manager to burn CDs
and DVDs.

1 Click Computer > More Applications > System Tools >  CD/DVD Creator, or just
insert a blank disk.

2 Copy the files and folders you want to put on the CD or DVD into the Nautilus
CD/DVD Creator window.
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3 Click Write to Disk.

4 Modify the relevant information in the Write to Disk dialog box, or accept the
default values, then click Write. The files are burned to the disk. This could take
a few minutes, depending on the amount of data being burned and the speed
of your burner.

You can also use the more advanced burning tool Brasero, or Banshee to burn data
and audio CDs.

16 Managing Your Digital Image Collection

F-Spot is a management tool for your collection of digital images, tailored for the
GNOME desktop. It allows you to assign different tags to your images in order to
categorize them, and offers various image editing options. For example, you can
remove red-eye, crop, and adjust brightness and colors. F-Spot supports all important
image formats, including JPEG, PNG, TIFF, and several vendor specific RAW formats.

You can import photos from your hard drive, your digital camera, or your iPod. You
can also use F-Spot to create photo CDs, generate a Website gallery, or export your
photos to your Flickr, 23, Picasa Web, or SmugMug account.

To access F-Spot, click Computer > F-Spot Photo Browser or press [Alt] + [F2] and
enter f-spot. The first time you run F-Spot, you must define the location from where
you want to import images into your collection. If you already have a collection of
images stored on your hard drive, enter the path to the directory and (optionally) include
subfolders. F-Spot imports these images into its database.
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Thumbnails of your images are displayed in the right part of the window, and detailed
information for a selected image is displayed in a sidebar to the left. By default, your
photos are displayed in reverse-chronological order, so your newest photos are always
at the top. You can sort your photos in chronological order or reverse-alphabetical order
by clicking View > Reverse Order.

A menu bar at the top of the window allows you to access the main menus. A toolbar
below offers several different functions depicted by a matching icon.

17 Managing Your Music and Videos

Use Banshee to import CDs, sync your media collection to a digital media player, play
music directly from a digital media player, create playlists with songs or videos from
your library, create audio and data CDs from subsets of your library, and subscribe to,
download, and listen to your favorite podcasts. Banshee also has an Internet Radio
plug-in that allows you to listen to audio streams.

To open Banshee, click Computer > Banshee Media Player or press [Alt] + [F2] and
enter banshee-1.

When you start Banshee for the first time, you need to import your media to make them
available in the library. To do so, select Media > Import Media from the menu. Choose
an import source and click Import. After successfully importing your media, you can
access them from your library.
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To play a song or a movie, simply select it in the library and click the play button. You
can also use the buttons in the upper left corner to pause a song or play the next or
previous song. Use the loudspeaker button on the right to adjust the volume.

Banshee also has an integrated CD player. When you insert a music CD, your CD title
appears in the left panel. Select the title and click the Play button to play your full CD.

To create audio and MP3 CDs, select the songs you want, then click the Edit > Write
CD from the menu.

18 Logging Out
When you are finished using the computer, you can log out and leave the system
running, or restart or shut down the computer.

18.1 Logging Out or Switching Users

Click Computer > Logout, then select one of the following options:

Log out  Logs you out of the current session and returns you to the login screen.

Switch User  Suspends your session, allowing another user to log in and use the
computer.

18.2 Restarting or Shutting Down the Computer

Click Computer > Shutdown, then select one of the following options:
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Shutdown  Logs you out of the current session, then turns off the computer.

Restart  Logs you out of the current session, then restarts the computer.

Suspend  Puts your computer in a temporary state that conserves power. The state
of your session is preserved, however, including all applications you have running and
all documents you have open.

Hibernate  Suspends your session, using no power until the computer is restarted.
The state of your session is preserved, however, including all applications you have
running and all documents you have open.

19 For More Information
To learn more about GNOME and GNOME applications, refer to http://www
.gnome.org/ .

http://www.gnome.org/
http://www.gnome.org/
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LibreOffice – это пакет многофункциональных офисных приложений с открытым
исходным кодом, предоставляющий инструменты для всех типов офисных задач,
таких как написание текстов, работа с таблицами, создание графиков, научных
формул и презентаций. С LibreOffice Вы можете использовать свои данные на
разных компьютерных платформах. Вы также можете открывать и редактировать
файлы в других форматах, включая форматы Microsoft Office и, затем сохранить
их в выбранном формате.

1 Совместимость

LibreOffice может работать с текстовыми документами, таблицами,
презентациями и базами данных разных форматах, включая форматы
Microsoft Office. С ними легко начать работать как и с файлами других
форматов, а так же сохранить в исходном формате. Хотя такие файлы
можно использовать при совместной работе, тем не менее, иногда возникают
сложности с форматированием. Если в документе выявилось нарушение
форматирования, то необходимо открыть их в оригинальном приложении и
повторно сохранить в открытом формате для текстовых документов, таком как,
например, RTF. В случае возникновения проблем с отображением табличных
файлов, рекомендуется повторно сохранить эти файлы в формате Excel и
использовать его как промежуточный формат (с форматом CSV возможна утрата
форматирования ячеек; CSV иногда приводит к некорректному распознаванию
типов ячеек).

2 Приложения LibreOffice

LibreOffice содержит несколько приложений (субпрограмм), спроектированных
на взаимодействия друг с другом. Все приложения имеют схожий графический
интерфейс пользователя и подобные функциональные возможности.
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Таблица 1 Приложения LibreOffice

Приложение Применение

Writer Текстовый процессор

Calc Электронные таблицы

Impress Презентации

Base Базы данных

Draw Векторный графический редактор

Math Составление математических
выражений

3 Что нового в LibreOffice

Со времени последнего выпуска openSUSE было внесено множество улучшений
во всех компонентах LibreOffice. Вот некоторые из них:

Общее меню поиска
Единое меню поиска теперь представлено в каждом приложении LibreOffice
для легкого поиска текстовых связок между открытыми документами. Поиск
можно активировать, перейдя в меню Вид > Панели инструментов > Найти.

Помощь в Интернет
Если ни один файл справки (libreoffice-help-*) не установлен, то
LibreOffice пытается показать соответствующую страницу справки в Интернет
с помощью Веб-браузера.

Новый диалог Печать
Диалог печати был переработан с целью объединения в одном месте таких
полезных функций, как простой предварительный просмотр страницы и выбор
количества печатаемых на странице листов.

Новый диалог Тезаурус
Диалог Тезаурус был улучшен и теперь в нем стало легче подобрать
аналогичные или соответствующие термины для придания документам более
отчетливого вида.

Импорт альфа-канала для TIFF изображений
Приложения LibreOffice теперь могут импортировать изображения RGBA TIFF
вместе с информацией о прозрачных областях.
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4 Запуск LibreOffice

Для запуска LibreOffice нажмите [Alt] + [F2], введите ooffice и нажмите [Enter].
В диалоге приветствия можно выбрать желаемое приложение. Если какое-
нибудь приложение LibreOffice уже открыто, то можно запустить любое другое
приложение путем нажатия Файл > Открыть > Название приложения.

4.1 Сохранение файлов LibreOffice

1 Для сохранения нового файла выберите Файл > Сохранить или Сохранить
как из Меню или воспользуйтесь комбинацией клавиш [Ctrl] + [Shift] + [S].

2 Выберите директорию, в которую нужно сохранить файл.

3 Введите имя файла в строке Имя.

4 В строке Фильтр выберите формат, в котором требуется сохранить файл.

В каждом приложении возможно сохранить свои документы как файлы
LibreOffice, шаблоны LibreOffice или как файлы Microsoft и StarOffice.

4.2 Навигатор и комбинации клавиш

Инструмент Навигатор представляет информацию о содержимом документа. Он
позволяет быстро перемещаться между различными элементами. Например,
можно использовать навигатор для быстрого просмотра всех имеющихся в
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документе изображений. Чтобы открыть Навигатор нажмите Вид > Навигатор
или нажмите [F5]. Элементы перечисленные в окне Навигатор варьируются в
зависимости от используемого приложения LibreOffice.

Кроме того, Вы можете перемещаться по файлам используя следующие
комбинации клавиш:

Таблица 2 Комбинации клавиш для навигации

Действие Комбинация клавиш

Удалить до конца слова [Ctrl] + [Delete]

Удалить до начала слова [Ctrl] + [<—]

К концу документа [Ctrl] + [End]

В конец строки [End]

Выбрать всё [Ctrl] + [A]

В начало строки [Home]

К началу документа [Ctrl] + [Home]

Перейти на слово левее [Ctrl] + [←]

Перейти на слово правее [Ctrl] + [→]

4.3 Использование и создание шаблонов

LibreOffice поставляется с набором готовых шаблонов, также дополнительные
шаблоны доступны в Интернет. Если необходимо создать собственный шаблон,
то для этого нужно определить как должен выглядеть документ и создать стили
используемые в шаблоне.

Для текстовых документов, таблиц, презентаций и векторных изображений
можно с легкостью создать шаблон из уже существующих файлов, по следующим
рекомендациям:

1 Запустите LibreOffice и откройте или создайте документ, содержащий
стили, которые необходимо использовать как шаблон.

2 Нажмите Файл > Шаблоны > Сохранить.

3 Укажите название шаблона.
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4 В подменю Категории выберите категорию, в которую нужно поместить
новый шаблон.

5 Нажмите OK.

5 LibreOffice Writer
LibreOffice Writer – это полнофункциональный текстовый процессор с богатыми
возможностями форматирования текста и страниц. Его внешний вид похож на
интерфейсы других подобных программ. Он имеет некоторые функции, которые,
обычно, можно найти только в дорогостоящих издательских приложениях.
Многие из функций LibreOffice Writer также задействованы в других приложениях
LibreOffice.

5.1 Что нового в Writer

Далее приведен список новых функций:

Улучшенные функции защиты документа
LibreOffice Writer и Calc теперь позволяют установить двухуровневую защиту
документа. Можно легко защитить документ при помощи пароля, который
предотвращает несанкционированное прочтение содержимого документа,
а также установить пароль для защиты документа от нежелательных
изменений. Таким образом, можно сделать содержимое документа доступным
только для чтения, для определенной группы пользователей, тогда как
пользователи другой группы смогут отредактировать этот документ документ.
Эта функция совместима с защищенными файлами Microsoft Word и Excel.

Установка для текста языка по умолчанию
Вы можете сбросить значение языка для текста на значение по умолчанию
используя языковую строку состояния или выбрав соответствующий пункт в
меню Сервис > Язык.

Улучшен диалог подсчёта количества слов
LibreOffice Writer теперь отображает количество символов в тексте документа
с учётом или без учёта пробелов.

Новые возможности для титульных страниц
Для вставки в документ титульной странице с различными опциями
форматирования нажмите правой кнопкой мыши и выберите Титульная
страница.... Документ может содержать несколько титульных страниц. Так,
например, Вы можете указать, чтобы нумерация страниц начиналась заново
после каждой титульной страницы.

5.2 Создание нового документа

Есть два способа создать новый документ:

Для создания совершенно нового документа нажмите Файл > Создать >
Текстовый Документ.
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Для использования стандартного формата и предопределённых элементов в
документах, попробуйте мастер (небольшая утилита, которая позволяет Вам на
основе некоторых основных предварительных требований к документу создать
его из подходящего шаблона). Например, для создания делового письма нажмите
Файл > Мастер > Письмо. С помощью мастера Вы можете создать простой
документ со стандартным форматированием.

Введите желаемый текст в окне документа. Воспользуйтесь панелью
инструментов Форматирование или меню Формат для придания документу
нужного внешнего вида. Используйте меню Файл или соответствующие кнопки на
панели инструментов для печати и сохранения документа. С помощью опций в
меню Вставка можно добавить в документ дополнительные элементы, такие как
таблицы, рисунки или графики.

5.3 Изменение настроек форматирования LibreOffice

С LibreOffice Вы можете изменить установки по умолчанию с помощью меню
Формат.

Далее приведен список наиболее востребованных опций, доступных в
большинстве модулей:

Изменение настроек символов
Для одновременной настройки всех символьных элементов выберите Формат
> Символы.
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Изменение настроек абзаца
Для форматирования абзацев выберите Формат > Абзац и выберите
соответствующий раздел для внесения изменений.

Изменение настроек выравнивания
Для изменения выравнивания текста выберите Формат > Абзац и выбрать
желательное выравнивание.

Вставка верхнего и нижнего колонтитула
Для добавления верхнего или нижнего колонтитула нажмите Вставка и
выберите, соответственно, Верхний колонтитул или Нижний колонтитул.

Вставка специальных символов
Для вставки специальных символов выберите Вставка > Специальные
символы.

Вставка сноски
Для вставки сноски нажмите Вставка и выберите Сноска.

Вставка колонок
Для вставки колонок нажмите Вставка и выберите Раздел.... На вкладке
Колонки укажите требуемое количество колонок для данного раздела.

Вставка оглавления и указателей
Для вставки оглавления или указателя нажмите Вставка и выберите
Оглавления и Указатели.

В меню Настройка доступны дополнительные опции форматирования.
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5.4 Использование составного документа

При работе с очень большими документами (такими как книги), возможно,
окажется более удобным работать с книгой при помощи составного документа,
чем при хранении книги в виде единого документа. Составной документ
позволяет быстро изменить форматирование всего документа или перейти в
каждый вложенный документ для редактирования.

Составной документ – это документ LibreOffice Writer, который служит
контейнером для множества файлов LibreOffice Writer. Вы можете работать
над главами или другими документами, как индивидуальными файлами,
собранными в составной документ. Составной документ особенно удобен, если
несколько людей работают над одним документом. Можно выделить для каждого
соответствующую часть документа в виде вложенного документа, позволяя
работать над документом одновременно, без риска повредить или удалить
записи друг друга.

1 Нажмите Создать > Составной Документ.

или

откройте существующий документ и выберите в меню Файл > Отправить
> Создать составной документ.

2 Добавьте вложенные документы.

3 Нажмите Сохранить.

Файлы справки LibreOffice содержат более подробную информацию о работе
с составными документами. Обратитесь к разделу Составные документы и
вложенные документы.

5.5 Использование Writer для редактирования HTML

Являясь полнофункциональным текстовым процессором, Writer также может
быть использован для редактирования HTML-файлов. Он воспринимает HTML-
теги таким-же образом, как и любые другие стили в текстовом документе.
Документ будет выглядеть так же, как он будет выведен на экран в Веб-браузере,
или же Вы можете напрямую редактировать HTML-код.

1 Нажмите Файл > Создать > Документ HTML.

2 Нажмите F11 для открытия окна Стили и форматирование.

3 Нажмите на стрелку внизу окна Стили и форматирование.

4 Выберите Стили HTML.

5 Создайте HTML-документ, используя стили, чтобы пометить текст.

6 Нажмите Файл > Сохранить как.
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7 Выберите местоположение для сохраняемого файла, имя файла, и
укажите документ HTML (.html) в строке Фильтр.

8 Нажмите Сохранить.

Если Вы предпочитаете напрямую редактировать HTML-код или необходимо
видеть HTML-код создаваемый при редактировании HTML-файла, как текстового
документа, нажмите Вид > Исходный текст HTML. В режиме отображения
исходного кода окно стили и форматирование не доступно. При первом
переключении в этот режим, будет предложено сохранить документ как HTML-
файл, если это не было сделано ранее.

5.6 Таблицы

Вы можете включить табличные данные в документы модулей Writer, Impress и
Draw. Вставить простую таблицу в документ можно при помощи соответствующих
элементов меню или используя панель инструментов:

• Вставка > Таблицу...,

• Таблица > Вставить > Таблицу...,

• или использовать значок Таблицу на панели инструментов.

Для ввода данных выберите ячейку с помощью курсора мыши и начните вводить
текст. Для перемещения между ячейками используйте клавиши со стрелками.
[→|] переместит курсор в следующую ячейку, [Shift] + [→|] – переместить курсор
в предыдущую ячейку.

Для изменения таблицы воспользуйтесь меню Таблица или панелью
инструментов Таблица.

6 LibreOffice Calc
Calc – это приложение LibreOffice для работы с табличными данными, а также
построения графиков и диаграмм. Электронные таблицы содержат несколько
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листов, включающих ячейки, которые могут быть заполнены такими элементами,
как текст, числа или формулы. С помощью формул можно манипулировать
данными из других ячеек для генерации значения в заданной ячейке, в
которую они были внесены. Calc позволяет систематизировать, фильтровать
и сортировать данные или создавать из их основе графики для графического
представления. Используя DataPilots Вы можете комбинировать, анализировать
и сравнивать большие массивы данных.

Как и весь комплект LibreOffice приложение Calc может быть использовано
на множестве программных платформ. Приложение поддерживает большое
количество форматов для обмена (включая экспорт в PDF), а также может читать
и сохранять файлы в формате Microsoft Excel.

6.1 Что нового в Calc

Далее приведен список новых функций:

Увеличенное количество строк на листе Calc
Calc теперь поддерживает 1 миллион строк, вместо прежних 65 536.

Поддержка графических объектов
Функции построения графиков и диаграмм были улучшены и теперь
поддерживают графические объекты. Панель инструментов рисование
позволяет добавлять такие простые фигуры, как линии, прямоугольники и
текстовые объекты, и даже комплексные фигуры, как кубы, символы, блоки-
указатели, блок-схемы и звёзды.

Интеллектуальный выбор фильтруемой области
Выбор сократился до фактически используемых столбцов данных при
включении фильтра (Авто-фильтр, Стандартный фильтр, Расширенный
фильтр). Пользователи могут выбрать строку нажав мышкой на заголовке
строки и применить фильтр для операции с данными в пределах выбранной
строки. Если выделена только одна строка, то выбор сокращается до
фактически используемых колонок данных и затем расширяется на все
смежные строки с данными. Выделение только части строки приведет к
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аналогичным результатам. Если выделена более, чем одна строка, то область
сокращается до колонок с фактически используемыми данными.

Задание цвета для ярлыка листа
Для каждого листа в документе Calc можно задать собственный цвет вкладки:
щелкните правой кнопкой мыши на вкладке и выберите Цвет ярлыка...,
выберите нужный цвет.

6.2 Создание нового документа

Запустите LibreOffice и выберите Файл > Создать > Электронную таблицу
для создания нового документа. Каждый лист доступен по нажатию на
соответствующей вкладке внизу окна.

Вводим данные в требуемые ячейки таблицы. Для изменения внешнего вида
или стиля, используйте панель инструментов Форматирование или меню
Формат. Воспользуйтесь меню Файл или соответствующей кнопкой на панели
инструментов для печати или сохранения документа.

6.3 Изменение настроек LibreOffice Calc

Для улучшения внешнего вида таблиц и отчетов, Calc поставляется со
встроенными стилями ячеек и листов. Несмотря на то, что встроенные стили
подходят большинству пользователей, возможно, создание собственных стилей
будет более удобным для установки необходимых настроек форматирования.

Процедура 17 Создание стиля

1 Нажмите Формат > Стили.

2 В окне Стили и форматирование нажмите на один из значков: Стили
страницы или Стили ячейки.

3 Нажмите правой кнопкой мыши в окне Стили и форматирование, затем
выберите Создать.

4 Укажите название нового стиля, и, используя различные вкладки,
выберите желаемые настройки форматирования.

5 Нажмите OK.

Процедура 18 Изменение стиля

1 Нажмите Формат > Стили.

2 В меню Стили и форматирование нажмите один из значков: Стили
страницы или Стили ячейки.

3 Нажмите правой кнопкой мыши на названии стиля, который необходимо
изменить, затем нажмите Изменить....

4 Измените существующие настройки форматирования.
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5 Нажмите ОК.

7 Другие приложения LibreOffice
Кроме Writer и Calc, LibreOffice также включает такие модули как Impress,
Base, Draw и Math. С помощью этих приложений можно создавать презентации,
проектировать базы данных, рисовать создавать векторные изображения и
диаграммы, формировать математические выражения.

7.1 Работа с презентациями в Impress

Приложение LibreOffice Impress применяется для создания презентационных
материалов как слайд-шоу или отдельные слайды. Если ранее использовалось
другое приложение для создания презентаций, то можно легко начать работать с
Impress, так как оно функционирует очень похоже на другие программы создания
презентаций.

Impress может открывать и сохранять презентации созданные в Microsoft
PowerPoint, то есть возможен обмен документами с пользователями PowerPoint,
также как и хранение Ваших файлов в формате PowerPoint.

Impress также позволяет использование 3D-переходов в слайдах. Доступ к
доступным эффектам можно получить, выбрав Демонстрация > Эффекты.

Вы можете создать совершенно новую презентацию (без каких-либо
предварительно отформатированных слайдов) или использовать существующие
шаблон или презентацию. Impress использует стили и шаблоны таким-же
образом, как и другие приложения LibreOffice. Мастер проведет Вас через опции,
доступных при создании новой презентации.

7.2 Работа с базами данных в Base

В состав LibreOffice входит модуль для работы с базами данных – Base. Он
используется для создания баз данных, хранящих в себе много разных видов
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информации: от простой адресной книги или рецептов, до сложных систем
управления документами.

Таблицы, формы, запросы и отчёты могут быть созданы вручную или с помощью
удобных мастеров. Например, мастер таблиц содержит множество типовых
полей для делового или персонального использования. С помощью такого
мастера можно пошагово создать новую базы данных.

LibreOffice Base поставляется с несколькими предопределёнными полями базы
данных, облегчающих создание базы данных. Мастер помогает поэтапно создать
новую базу данных. Следующие шаги специфичны для создания адресной
книги, используются предопределённые поля, но также легко использовать
стандартные поля из предложенных образцов таблиц. Процесс создания базы
данных можно разбить на несколько отдельных под-процессов:

Процедура 19 Создание базы данных

1 Нажмите Файл > Создать > Базу данных.

2 Выберите Создать новую базу данных и нажмите Далее.

3 Нажмите Да, зарегистрировать базу данных, чтобы информация о
создаваемой базе данных была доступна другим модулям LibreOffice,
отметьте оба флажка в нижней половине окна и нажмите Готово.

4 Выберите директорию в которой будет размещен файл базы данных,
укажите его имя, затем нажмите Сохранить.

Процедура 20 Создание таблицы базы данных

1 Нажмите на значок Таблицы на левой напели и выберите Использовать
мастер для создания таблицы.

2 В окне Мастер таблиц выберите Персональные.

3 Меню Примеры таблиц содержит список стандартных таблиц для
персонального использования. При выборе Деловые, список будет
содержать предустановленные деловые таблицы.

В списке Примеры таблиц выберите Адреса. Возможные поля для
стандартной адресной книги появятся в меню Переменные поля.

4 В меню Переменные поля выберите желаемые поля которые Вы хотите
использовать в адресной книге.

Вы можете выбрать каждый объект по отдельности или сразу несколько
удерживая [Shift].

5 Нажать кнопку с одиночной стрелкой для перемещения выбранных полей
в меню Выбранные поля.

Для перемещения всех возможных полей в меню Выбранные поля
нажмите на кнопку с двойной стрелкой.
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6 Используйте кнопки со стрелками для размещения выбранных полей в
требуемом порядке и нажмите Готово.

Поля будут помещены в таблице и на формах в указанном порядке.

7.3 Создание рисунка в Draw

Используйте LibreOffice Draw для создания рисунков и диаграмм. Вы можете
сохранить Вашу работу в наиболее распространенных на данный момент
форматах и импортировать ее в любом приложении поддерживающем данную
операцию, включая другие модули LibreOffice. Вы так же можете создать Flash-
версию Вашего векторного изображения.

Процедура 21 Создание рисунка

1 Нажмите [Alt] + [F2] и введите oodraw, чтобы запустить LibreOffice Draw.

2 Используйте элементы меню внизу окна для создания рисунка.

3 Сохраните рисунок.

Для вставки существующего рисунка Draw в документ LibreOffice выберите
Вставка > Объект > Объект OLE. Выберите Создать из файла и нажмите Обзор,
чтобы выбрать нужный файл. При вставке файла как OLE-объекта Вы можете
легко его отредактировать дважды нажав на нем.

Процедура 22 Использование функций Draw в других модулях LibreOffice

Одной из особенностей использования Draw является возможность
использования его функций в других модулях LibreOffice, что позволяет
создавать рисунки, автоматически встраиваемые в документ.

1 Нажмите в модуле LibreOffice (например, Writer) Вставка > Объект >
Объект OLE... > Рисунок LibreOffice 3.3 > OK. Откроется окно Draw.

2 Создайте рисунок.
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3 Поместите курс в документе за пределами рамки Draw.

Рисунок будет автоматически вставлен в документ.

7.4 Создание математических выражений с помощью Math

Обычно включение комплексных математических формул в документ является
нетривиальной задачей. LibreOffice Math – редактор математических выражений,
который позволяет создавать формулы содержащие операторы, функции и
укажания по форматированию. Вы можете сохранить эти формулы как объекты,
которые могут быть импортированы в другие документы LibreOffice, как любые
другие графические объекты.

Используя Math можно создавать уравнения и формулы тремя различными
способами:

• Ввести разметку в редактор формул,

• нажмите правой кнопкой мыши в редакторе формул и выберите символ из
контекстного меню

или

• выберите его в окне Элементы.

ЗАМЕЧАНИЕ

Math – не калькулятор. Выражения которые в нем создаются являются
графическими объектами. Даже, если они были импортированы в Calc – по
ним невозможно произвести какие-либо вычисления.

8 Дополнительная информация
LibreOffice содержит обширную справочную информацию доступную в Интернет.
Её сопровождает многочисленное сообщество пользователей и разработчиков.
Для получения дополнительной информации перейдите по следующей ссылке:

http://www.libreoffice.org/
Домашняя страница проекта LibreOffice.

http://openoffice.org/dev_docs/features/3.3
Список всех нововведений и улучшений LibreOffice.

http://support.openoffice.org/index.html
Официальная страница поддержки LibreOffice, содержащая руководства и
другую документацию.

http://www.taming-openoffice-org.com/
Приручение LibreOffice: книги, новости, советы и хитрости.

http://www.libreoffice.org/
http://openoffice.org/dev_docs/features/3.3
http://support.openoffice.org/index.html
http://www.taming-openoffice-org.com/
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http://documentation.LibreOffice/HOW_TO/index.html
Подробные пошаговые руководства для разнообразных задач решаемых с
помощью LibreOffice, включая создание и использование шаблонов.

http://documentation.LibreOffice/HOW_TO/index.html


A Помощь и решение проблем

A.1 Справка и документация
openSUSE® сопровождается различными источниками информации и
документации, многие из которых уже интегрированы в установленную систему.

Документация в /usr/share/doc
Этот традиционный каталог в котором размещаются различные файлы
документации и информация о версии Вашей системы. Здесь также
содержится информация из установленных пакетов в подкаталоге packages.
За дополнительной информацией обратитесь к Раздел A.1.1, «Каталог
документации» (стр. 79).

Электронное руководства (man) и info-страницы для команд оболочки
При работе в командной строке Вам не нужно помнить все опции
командах. Традиционно, оболочка предоставляет пользователю доступ
к интегрированной справке посредством man- и info-страниц. За
дополнительной информацией обратитесь к Раздел A.1.2, «Man Pages»
(стр. 81) и Раздел A.1.3, «Info Pages» (стр. 82).

Центр справки рабочего стола
Центр справки обоих рабочих столов – KDE (Центр справки KDE) и GNOME
(Help) – предоставляет централизованный доступ к большинству важных
ресурсов документации в Вашей системе в доступной для поиска форме. Эти
ресурсы включают справку доступную в сети для установленных приложений,
электронное руководства, info-страницы и руководства поставляемые вместе
с продуктом Novell/SUSE.

Отдельные пакеты со справочными материалами для некоторых приложений
При установке нового программного обеспечения с помощью YaST,
документация поставляемая вместе с этими программами устанавливается
автоматически (в большинстве случаев) и обычно появляется в центре
справки Вашего рабочего стола. Однако, для некоторых приложений, таких
как GIMP, также могут быть доступны дополнительные пакеты со справкой
из сети, которая не интегрируется в центр справки; Вы можете установить их
отдельно с помощью YaST.

A.1.1 Каталог документации

 Традиционным каталогом для размещения различных файлов документации
в Linux системах является /usr/share/doc . Обычно, в нем содержится
информацию о пакетах установленных на Вашей системе, а также информация
о версии системы, руководства, и другие справочные материалы.
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ЗАМЕЧАНИЕ: Содержимое зависит от установленных пакетов

В мире Linux многие руководства и другие виды документации доступны в
форме пакетов, точно так же как программы. Сколько и какую информацию
Вы найдете в /usr/share/docs , также зависит от установленных пакетов.
Если Вы не можете найти подкаталоги упомянутые здесь – проверьте:
установлены ли соответствующие пакеты в Вашей системе с помощью YaST
и установите их, если требуется.

Руководства Novell/SUSE

  Мы предоставляем HTML- и PDF-версии наших книги на различных языках.
В подкаталоге manual Вы можете найти HTML-версии большинства руководств
Novell/SUSE доступных для Вашего продукта. Краткий обзор всей документации,
доступной для Вашего продукта, находится в вступительной части данного
руководства.

Еслиустановлено больше одного языка, то в каталоге /usr/share/doc/
manual  могут находиться руководства на разных языках. HTML-версия
руководств Novell/SUSE также доступна в центре справки обоих рабочих столов.
Для получения информации о том, где найти PDF- и HTML-версии книг на
установочном носителе, обратитесь к примечанию к выпуску openSUSE. Они
доступны в установленной системе в каталоге /usr/share/doc/release
-notes/  или в сети, на веб-странице относящейся к Вашему продукту http://
www.novell.com/documentation/ .

Пошаговые руководства

 Если пакеты howto установлены, то в директории /usr/share/doc
будет находится подкаталог howto, в котором Вы найдете дополнительную
документацию по выполнению многих задач, касающихся установки и работы с
программным обеспечением Linux.

Документация пакетов

 Внутри каталога packages можно найти документацию которая была включена
в состав пакетов программного обеспечения, установленного в Вашей системе.
Для каждого пакета создается подкаталог /usr/share/doc/packages/
имя_пакета . Здесь находятся файлы README и, иногда, примеры
конфигурационных файлов или дополнительных сценариев. Следующий
ниже список даст представление о типичных файлах, которые могут быть
найдены в каталоге /usr/share/doc/packages . Ни один из этих пунктов
не обязательны; многие пакеты могут содержать только некоторые из
перечисленных файлов.

AUTHORS
Список главных разработчиков.

http://www.novell.com/documentation/
http://www.novell.com/documentation/
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BUGS
Известные ошибки или неправильная работа некоторых функций. Также
может содержать ссылку на страницу Bugzilla, где Вы можете найти все
сообщения об ошибках.

CHANGES  ,  ChangeLog
Список внесенных изменений между двумя последними версиями. Обычно
интересен для разработчиков, так как это информация представлена очень
подробно.

COPYING  ,  LICENSE
Лицензионная информация.

FAQ
Сборник часто задаваемых вопросов и ответов на них из списков рассылок
или новостных групп.

INSTALL
Описывает как установить этот пакет на Вашей системе. Поскольку пакет уже
будет установлен к тому моменту, когда Вы сможете просчитать этот файл,
Вы можете смело проигнорировать его содержание.

README, README.*
Главная информация о программном обеспечении. Например, для чего
предназначено и как его использовать.

TODO
Вещи, которые еще не реализованы, но вероятно будут воплощены в
будущем.

MANIFEST
Список файлов с краткой сводкой.

NEWS
Описание нововведений реализованных в этой версии.

A.1.2 Man Pages

Man pages are an essential part of any Linux system. They explain the usage of a
command and all available options and parameters. Man pages can be accessed with
man followed by the name of the command, for example, man ls.

Man pages are displayed directly in the shell. To navigate them, move up and down with
[Page Up] and [Page Down]. Move between the beginning and the end of a document
with [Home] and [End]. End this viewing mode by pressing [Q]. Learn more about the
man command itself with man man. Man pages are sorted in categories as shown in
Таблица A.1, «Man Pages—Categories and Descriptions» (стр. 82) (taken from
the man page for man itself).
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Таблица A.1 Man Pages—Categories and Descriptions

Number Description

1 Executable programs or shell
commands

2 System calls (functions provided by the
Kernel)

3 Library calls (functions within program
libraries)

4 Special files (usually found in /dev)

5 File formats and conventions (/etc/
fstab )

6 Games

7 Miscellaneous (including macro
packages and conventions), for
example, man(7), groff(7)

8 System administration commands
(usually only for root)

9 Kernel routines (nonstandard)

Each man page consists of several parts labeled NAME, SYNOPSIS, DESCRIPTION,
SEE ALSO, LICENSING, and AUTHOR. There may be additional sections available
depending on the type of command.

A.1.3 Info Pages

Info pages are another important source of information on your system. Usually, they
are more detailed than man pages. To view the info page for a certain command, enter
info followed by the name of the command, for example, info ls. You can browse
an info page with a viewer directly in the shell and display the different sections, called
«nodes». Use [Пробел] to move forward and [<—] to move backwards. Within a node,
you can also browse with [Page Up] and [Page Down] but only [Пробел] and [<—] will
take you also to the previous or subsequent node. Press [Q] to end the viewing mode.
Not every man page comes with an info page and vice versa.
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A.1.4 Online Resources

 In addition to the online versions of the openSUSE manuals installed under /usr/
share/doc , you can also access the product-specific manuals and documentation
on the Web. For an overview of all documentation available for openSUSE check out
your product-specific documentation Web page at http://doc.opensuse.org .

If you are searching for additional product-related information, you can also refer to
the following Web sites:

openSUSE Wiki
Detailed information about lots of different aspects of the openSUSE system can
be found in our Wiki at http://en.opensuse.org . You may also contribute
to each Wiki page and change or add new pages.

openSUSE Support Database
The openSUSE Support Database (SDB) can be found at http://

en.opensuse.org/Portal:Support_database . It features articles
written as solutions for technical problems with openSUSE. They cover issues from
installation and configuration, to workarounds for bugs and missing features.

openSUSE Forums
There are several openSUSE forums where you can dive in on discussions about
openSUSE, or get support. See http://en.opensuse.org/openSUSE:
Forums_list  for a list.

KDE Documentation
Find documentation for many aspects of KDE suitable for users and administrators
at http://www.kde.org/documentation/ .

GNOME Documentation
Documentation for GNOME users, administrators and developers is available at
http://library.gnome.org/ .

The Linux Documentation Project
The Linux Documentation Project (TLDP) is run by a team of volunteers who write
Linux-related documentation (see http://www.tldp.org ). It's probably the
most comprehensive documentation resource for Linux. The set of documents
contains tutorials for beginners, but is mainly focused on experienced users and
professional system administrators. TLDP publishes HOWTOs, FAQs, and guides
(handbooks) under a free license. Parts of the documentation from TLDP is also
available on openSUSE

You might also want to try general-purpose search engines. For example, you might
try the search terms Linux CD-RW help or OpenOffice file conversion
problem if you were having trouble with the CD burning or with OpenOffice.org
file conversion. Google™ also has a Linux-specific search engine at http://www
.google.com/linux  that you might find useful.

http://doc.opensuse.org
http://en.opensuse.org
http://en.opensuse.org/Portal:Support_database
http://en.opensuse.org/Portal:Support_database
http://en.opensuse.org/openSUSE:Forums_list
http://en.opensuse.org/openSUSE:Forums_list
http://www.kde.org/documentation/
http://library.gnome.org/
http://www.tldp.org
http://www.google.com/linux
http://www.google.com/linux
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A.1.5 Support for openSUSE

Useful support information for openSUSE is available in a number of sources:

• Free installation support for retail box customer.

• Free community support http://en.opensuse.org/Communicate .

If you encounter problems with the installation or use of openSUSE that you are unable
to solve, our experienced support staff can offer practical assistance with the free
installation support for registered releases. Nearly all common customer problems can
be eliminated quickly and competently. You can use the extensive support offered
through the community, as well.

Free Installation Support

Our free installation support is provided for a period of 90 days following the
activation of your registration code http://www.open-slx.com/register
or following the release of the next version. If you cannot find an answer to your
question in any of the available information sources, we will gladly provide assistance
for the following issues:

• Installation on a typical home user system or laptop equipped with a single
processor, at least 512 MB RAM (1024 MB recommended), and 8 GB of free hard
disk space.

• Resizing of one Windows partition that occupies the entire hard disk.

• Dual-boot installation with Windows, limited to Linux Support.

• Installation of a local ATAPI CD or DVD drive.

• Installation from a remote CD/DVD drive

• Installation on the first or second hard disk in an IDE-only system (/dev/sda  or
/dev/sdb ) or supported S-ATA system, excluding RAID.

• Integration of a standard keyboard and standard mouse.

• Configuration of the graphical user interface (without the hardware acceleration
feature of the graphics card).

• Installation of the boot manager in the MBR of the first hard disk without modifying
the BIOS mapping.

• Setup of Internet access with a supported PCI ISDN card or external serial modem
(not USB). Conversely, setup of DSL based on PPPoE with a supported NIC.

• Basic configuration of a supported WLAN adapter.

http://en.opensuse.org/Communicate
http://www.open-slx.com/register
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• Basic configuration of an ALSA-supported PCI sound card.

• Basic configuration of a locally-attached compatible printer with YaST.

• Basic configuration of an IDE CD writer for use with k3b (CD burning application)
without changing the jumper setting.

• Configuration of a supported PCI ethernet card for LAN access with either DHCP
(client) or static IP. This does not include the configuration of the LAN or any other
computers or network components. It also does not cover the configuration of the
computer as a router. Fault analysis is limited to checking for proper loading of the
kernel module and the correct local network settings.

• Configuration of an e-mail client (Evolution and KMail) for collecting mail from a
POP3 account. Fault analysis is limited to checking for proper settings in the e-
mail client.

• Support for the package selection KDE Desktop or GNOME Desktop.

• Upgrade from the previous version of the product.

• Kernel updates (only official Novell update RPMs).

• Installation of bug fixes and security updates from the official update server using
online update or the manual method.

For a detailed listing of the subjects covered by the free installation support, check
http://www.open-slx.com/support .

In case you are not sure if your support is covered, please do not hesitate to give us
a call. We are happy to assist.

Contact Information for Free Installation Support

Reach our support staff under the following links and phone numbers. Our installation
support is offered through call back. After your problem description our staff either tries
to call you back in the next 2 hours or arrange a time for a call back. Please register your
product at http://www.open-slx.com/register  prior to your support
request.

• http://support.open-slx.com/eService

• United States and Canada: +1-404-5854-269

• Germany, Austria, Switzerland: Phone: +49 (0)911-8946-0303

• UK: +44-2030-025-943

• All other countries (English only): please see http://www.open-slx
.com/support .

http://www.open-slx.com/support
http://www.open-slx.com/register
http://support.open-slx.com/eService
http://www.open-slx.com/support
http://www.open-slx.com/support
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For the most recent contact information, refer to http://www.open-slx.com/
support .

Important Notes

1. Free installation support is offered to customers with a valid and activated
registration code. You can activate your registration code at http://www
.open-slx.com/register/ .

2. The registration code is not transferable to another person.

3. The free support covers the initial installation on one computer. Refer to our Web
site for further information http://www.open-slx.com/support .

Contact Recommendations

We recommend using http://support.open-slx.com/eService  to
open a service request and to provide us with the relevant information like problem
description and log files. It helps us to avoid misspelled commands, links, or directory
names, which often cause frustrating problems and are particularly common during
phone conversations. You will receive a reply soon, providing a practical solution.

Preparing a Support Request

We endeavor to help you as quickly and precisely as possible. The effort and time
needed is considerably reduced if the question is formulated clearly. Please have
answers to the following questions ready before contacting us:

1. Which program and version are you using? During which process does the problem
occur?

2. What exactly is the problem? Try to describe the error as precisely as possible,
using phrases with words such as when (for example, «When X is pressed, this
error appears»).

3. What hardware do you use (graphics card, monitor, printer, ISDN card, etc.)? You
can get this information from the YaST Hardware Information module.

Detailed documentation can be found in manuals, online help, and the Support
Database. This comprehensive documentation of openSUSE gives guidance to solve
a variety of problems. The SUSE Help Center on your desktop provides additional
information about installed packages, the vital HOWTOs, and info pages.

You can access the latest Support Database articles online at http://www
.open-slx.com/support  or access the community Support Database at
http://en.opensuse.org/Portal:Support_database . The Support
Database, one of the most frequently used databases in the Linux world, offers our
customers a wealth of analysis and solution approaches. You can retrieve tested
solutions using the keyword search, history function, or version-dependent search.

http://www.open-slx.com/support
http://www.open-slx.com/support
http://www.open-slx.com/register/
http://www.open-slx.com/register/
http://www.open-slx.com/support
http://support.open-slx.com/eService
http://www.open-slx.com/support
http://www.open-slx.com/support
http://en.opensuse.org/Portal:Support_database
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A.2 Common Problems and Their Solutions
This chapter describes a range of potential problems and their solutions. Even if your
situation is not precisely listed here, there may be one similar enough to offer hints to
the solution of your problem.

A.2.1 Finding and Gathering Information

Linux reports things in a very detailed way. There are several places to look when you
encounter problems with your system, most of which are standard to Linux systems
in general, and some of which are relevant to openSUSE systems. The two most
important system logs are /var/log/boot.msg  and /var/log/messages .

A list of the most frequently checked log files follows with the description of their typical
purpose. Paths containing ~  refer to the current user's home directory.

Таблица A.2 Log Files

Log File Description

~/.xsession-errors Messages from the desktop
applications currently running.

/var/log/apparmor/ Log files from AppArmor, see
Часть “Ограничение привилегий с
Novell AppArmor” (↑Руководство по
безопасности) for detailed information.

/var/log/boot.msg Messages from the kernel reported
during the boot process.

/var/log/mail.* Messages from the mail system.

/var/log/messages Ongoing messages from the kernel
and system log daemon (when
running).

/var/log/NetworkManager Log file from NetworkManager
to collect problems with network
connectivity

/var/log/samba/ Directory containing Samba server and
client log messages.

/var/log/SaX.log Hardware messages from the SaX
display and KVM system.
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Log File Description

/var/log/warn All messages from the kernel and
system log daemon with the «warning»
level or higher.

/var/log/wtmp Binary file containing user login records
for the current machine session. View it
with last.

/var/log/Xorg.*.log Various start-up and runtime logs from
the X Window system. It is useful for
debugging failed X start-ups.

/var/log/YaST2/ Directory containing YaST's actions
and their results.

/var/log/zypper.log Log file of zypper.

Apart from log files, your machine also supplies you with information about the running
system. See Таблица A.3: System Information With the /proc File System

Таблица A.3 System Information With the /proc File System

File Description

/proc/cpuinfo Contains processor information,
including its type, make, model, and
performance.

/proc/dma Shows which DMA channels are
currently being used.

/proc/interrupts Shows which interrupts are in use, and
how many of each have been in use.

/proc/iomem Displays the status of I/O (input/output)
memory.

/proc/ioports Shows which I/O ports are in use at the
moment.

/proc/meminfo Displays memory status.
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File Description

/proc/modules Displays the individual modules.

/proc/mounts Displays devices currently mounted.

/proc/partitions Shows the partitioning of all hard disks.

/proc/version Displays the current version of Linux.

Apart from the /proc file system, the Linux kernel exports information with the
sysfs module, an in-memory filesystem. This module represents kernel objects, their
attributes and relationships. For more information about sysfs, see the context of
udev in Глава 20, Dynamic Kernel Device Management with udev (↑Reference).
Таблица A.4 contains an overview of the most common directories under /sys.

Таблица A.4 System Information With the /sys File System

File Description

/sys/block Contains subdirectories for each block
device discovered in the system.
Generally, these are mostly disk type
devices.

/sys/bus Contains subdirectories for each
physical bus type.

/sys/class Contains subdirectories grouped
together as a functional types of
devices (like graphics, net, printer, etc.)

/sys/device Contains the global device hierarchy.

Linux comes with a number of tools for system analysis and monitoring. See Chapter 2,
System Monitoring Utilities (↑System Analysis and Tuning Guide) for a selection of the
most important ones used in system diagnostics.

Each of the following scenarios begins with a header describing the problem followed
by a paragraph or two offering suggested solutions, available references for more
detailed solutions, and cross-references to other scenarios that are related.
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A.2.2 Installation Problems

Installation problems are situations when a machine fails to install. It may fail entirely
or it may not be able to start the graphical installer. This section highlights some of the
typical problems you may run into, and offers possible solutions or workarounds for
these kinds of situations.

Checking Media
If you encounter any problems using the openSUSE installation media, check the
integrity of your installation media. Boot from the media and choose Check Installation
Media from the boot menu. In a running system, start YaST and choose Software >
Media Check. Media problems are more probable with the media you burn yourself.
Burning the media at a low speed (4x) helps avoiding problems.

Hardware Information
Display detected hardware and technical data using Hardware > Hardware Information
in YaST. Click any node of the tree for more information about a device. This module
is especially useful, when submitting a support request for which you need information
about your hardware.

Save the displayed hardware information to a file by clicking Save to File. Select the
desired directory and filename then click Save to create the file.

No Bootable DVD Drive Available

If your computer does not contain a bootable DVD-ROM drive or if the one you have is
not supported by Linux, there are several options you can install your machine without
a built-in DVD drive:

Using an External Boot Device
If it is supported by your BIOS and the installation kernel, boot from external DVD
drives or USB storage devices.

Network Boot via PXE
If a machine lacks a DVD drive, but provides a working ethernet connection, perform
a completely network-based installation. See Раздел “Remote Installation via VNC
—PXE Boot and Wake on LAN” (Глава 2, Remote Installation, ↑Reference) and
Раздел “Remote Installation via SSH—PXE Boot and Wake on LAN” (Глава 2,
Remote Installation, ↑Reference) for details.

External Boot Devices

Linux supports most existing DVD drives. If the system has neither a DVD drive nor
a floppy disk, it is still possible that an external DVD drive, connected through USB,
FireWire, or SCSI, can be used to boot the system. This depends mainly on the
interaction of the BIOS and the hardware used. Sometimes a BIOS update may help
if you encounter problems.

When installing from a KDE or GNOME Live CD, you can also create a «Live
USB stick» to boot from. Refer to http://en.opensuse.org/Live_USB
_stick  for detailed instructions.

http://en.opensuse.org/Live_USB_stick
http://en.opensuse.org/Live_USB_stick
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Booting from Installation Media Fails

One reason why a machine does not boot the installation media can be an incorrect
boot sequence setting in BIOS. The BIOS boot sequence must have DVD drive set
as the first entry for booting. Otherwise the machine would try to boot from another
medium, typically the hard disk. Guidance for changing the BIOS boot sequence
can be found the documentation provided with your motherboard, or in the following
paragraphs.

The BIOS is the software that enables the very basic functions of a computer.
Motherboard vendors provide a BIOS specifically made for their hardware. Normally,
the BIOS setup can only be accessed at a specific time—when the machine is booting.
During this initialization phase, the machine performs a number of diagnostic hardware
tests. One of them is a memory check, indicated by a memory counter. When the
counter appears, look for a line, usually below the counter or somewhere at the bottom,
mentioning the key to press to access the BIOS setup. Usually the key to press is one
of [Del], [F1], or [Esc]. Press this key until the BIOS setup screen appears.

Процедура A.1 Changing the BIOS Boot Sequence

1 Enter the BIOS using the proper key as announced by the boot routines and
wait for the BIOS screen to appear.

2 To change the boot sequence in an AWARD BIOS, look for the BIOS
FEATURES SETUP entry. Other manufacturers may have a different name for
this, such as ADVANCED CMOS SETUP. When you have found the entry,
select it and confirm with [Enter].

3 In the screen that opens, look for a subentry called BOOT SEQUENCE or BOOT
ORDER. The boot sequence looks something like C,A or A,C. In the former
case, the machine first searches the hard disk (C) then the floppy drive (A) to
find a bootable medium. Change the settings by pressing [PgUp] or [PgDown]
until the sequence is A,CDROM,C.

4 Leave the BIOS setup screen by pressing [Esc]. To save the changes, select
SAVE & EXIT SETUP, or press [F10]. To confirm that your settings should be
saved, press [Y].

Процедура A.2 Changing the Boot Sequence in a SCSI BIOS (Adaptec Host
Adapter)

1 Open the setup by pressing [Ctrl] + [A].

2 Select Disk Utilities. The connected hardware components are now displayed.

Make note of the SCSI ID of your DVD drive.

3 Exit the menu with [Esc].

4 Open Configure Adapter Settings. Under Additional Options, select Boot Device
Options and press [Enter].
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5 Enter the ID of the DVD drive and press [Enter] again.

6 Press [Esc] twice to return to the start screen of the SCSI BIOS.

7 Exit this screen and confirm with Yes to boot the computer.

Regardless of what language and keyboard layout your final installation will be using,
most BIOS configurations use the US keyboard layout as depicted in the following
figure: 

Рисунок A.1 US Keyboard Layout

Fails to Boot

Some hardware types, mainly very old or very recent ones, fail to install. In many cases,
this may happen because support for this type of hardware is missing in the installation
kernel, or due to certain functionality included in this kernel, such as ACPI, that can
still cause problems on some hardware.

If your system fails to install using the standard Installation mode from the first
installation boot screen, try the following:

1 With the DVD still in the drive, reboot the machine with [Ctrl] + [Alt] + [Delete]
or using the hardware reset button.

2 When the boot screen appears, press [F5], use the arrow keys of your keyboard
to navigate to No ACPI and press [Enter] to launch the boot and installation
process. This option disables the support for ACPI power management
techniques.

3 Proceed with the installation as described in Глава 1, Installation with YaST
(↑Reference).

If this fails, proceed as above, but choose Safe Settings instead. This option disables
ACPI and DMA support. Most hardware will boot with this option.

If both of these options fail, use the boot options prompt to pass any additional
parameters needed to support this type of hardware to the installation kernel.
For more information about the parameters available as boot options, refer to the
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kernel documentation located in /usr/src/linux/Documentation/kernel
-parameters.txt .

ПОДСКАЗКА: Obtaining Kernel Documentation

Install the kernel-source package to view the kernel documentation.

There are various other ACPI-related kernel parameters that can be entered at the
boot prompt prior to booting for installation:

acpi=off
This parameter disables the complete ACPI subsystem on your computer. This may
be useful if your computer cannot handle ACPI at all or if you think ACPI in your
computer causes trouble.

acpi=force
Always enable ACPI even if your computer has an old BIOS dated before the year
2000. This parameter also enables ACPI if it is set in addition to acpi=off.

acpi=noirq
Do not use ACPI for IRQ routing.

acpi=ht
Run only enough ACPI to enable hyper-threading.

acpi=strict
Be less tolerant of platforms that are not strictly ACPI specification compliant.

pci=noacpi
Disable PCI IRQ routing of the new ACPI system.

pnpacpi=off
This option is for serial or parallel problems when your BIOS setup contains wrong
interrupts or ports.

notsc
Disable the time stamp counter. This option can be used to work around timing
problems on your systems. It is a recent feature, if you see regressions on your
machine, especially time related or even total hangs, this option is worth a try.

nohz=off
Disable the nohz feature. If your machine hangs, this option may help. Otherwise
it is of no use.

Once you have determined the right parameter combination, YaST automatically writes
them to the boot loader configuration to make sure that the system boots properly next
time.

If unexplainable errors occur when the kernel is loaded or during the installation, select
Memory Test in the boot menu to check the memory. If Memory Test returns an error,
it is usually a hardware error.
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Fails to Launch Graphical Installer

After you insert the medium into your drive and reboot your machine, the installation
screen comes up, but after you select Installation, the graphical installer does not start.

There are several ways to deal with this situation:

• Try to select another screen resolution for the installation dialogs.

• Select Text Mode for installation.

• Do a remote installation via VNC using the graphical installer.

Процедура A.3 Change Screen Resolution for Installation

1 Boot for installation.

2 Press [F3] to open a menu from which to select a lower resolution for installation
purposes.

3 Select Installation and proceed with the installation as described in Глава 1,
Installation with YaST (↑Reference).

Процедура A.4 Installation in Text Mode

1 Boot for installation.

2 Press [F3] and select Text Mode.

3 Select Installation and proceed with the installation as described in Глава 1,
Installation with YaST (↑Reference).

Процедура A.5 VNC Installation

1 Boot for installation.

2 Enter the following text at the boot options prompt:

vnc=1 vncpassword=some_password

Replace some_password with the password to use for VNC installation.

3 Select Installation then press [Enter] to start the installation .

Instead of starting right into the graphical installation routine, the system
continues to run in a text mode, then halts, displaying a message containing the
IP address and port number at which the installer can be reached via a browser
interface or a VNC viewer application.

4 If using a browser to access the installer, launch the browser and enter
the address information provided by the installation routines on the future
openSUSE machine and hit [Enter]:
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http://ip_address_of_machine:5801

A dialog opens in the browser window prompting you for the VNC password.
Enter it and proceed with the installation as described in Глава 1, Installation
with YaST (↑Reference).

ВАЖНО

Installation via VNC works with any browser under any operating system,
provided Java support is enabled.

Provide the IP address and password to your VNC viewer when prompted. A
window opens, displaying the installation dialogs. Proceed with the installation
as usual.

Only Minimalistic Boot Screen Started

You inserted the medium into the drive, the BIOS routines are finished, but the system
does not start with the graphical boot screen. Instead it launches a very minimalistic
text-based interface. This may happen on any machine not providing sufficient graphics
memory for rendering a graphical boot screen.

Although the text boot screen looks minimalistic, it provides nearly the same
functionality as the graphical one:

Boot Options
Unlike the graphical interface, the different boot options cannot be selected using
the cursor keys of your keyboard. The boot menu of the text mode boot screen
offers some keywords to enter at the boot prompt. These keywords map to the
options offered in the graphical version. Enter your choice and hit [Enter] to launch
the boot process.

Custom Boot Options
After selecting a boot option, enter the appropriate keyword at the boot prompt or
enter some custom boot options as described in «Fails to Boot» (стр. 92). To
launch the installation process, press [Enter].

Screen Resolutions
Use the F keys to determine the screen resolution for installation. If you need to
boot in text mode, choose [F3].

A.2.3 Boot Problems

Boot problems are situations when your system does not boot properly (does not boot
to the expected runlevel and login screen).

Fails to Load the GRUB Boot Loader

If the hardware is functioning properly, it is possible that the boot loader is corrupted
and Linux cannot start on the machine. In this case, it is necessary to repair the boot
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loader. To do so, you need start the Rescue System as described in Раздел A.2.7,
«Recovering a Corrupted System» (стр. 108) and follow the instructions at
«Modifying and Reinstalling the Boot Loader» (стр. 111).

Other reasons for the machine not booting may be BIOS-related:

BIOS Settings
Check your BIOS for references to your hard drive. GRUB may simply not be started
if the hard drive itself cannot be found with the current BIOS settings.

BIOS Boot Order
Check whether your system's boot order includes the hard disk. If the hard disk
option was not enabled, your system may install properly, but fails to boot when
access to the hard disk is required.

No Graphical Login

If the machine comes up, but does not boot into the graphical login manager, anticipate
problems either with the choice of the default runlevel or the configuration of the X
Window System. To check the runlevel configuration, log in as the root user and check
whether the machine is configured to boot into runlevel 5 (graphical desktop). A quick
way to check this is to examine the contents of /etc/inittab , as follows:

tux@mercury:~> grep "id:" /etc/inittab 
id:5:initdefault:

The returned line indicates that the machine's default runlevel (initdefault) is set
to 5 and that it should boot to the graphical desktop. If the runlevel is set to any other
number, use the YaST Runlevel Editor module to set it to 5.

ВАЖНО

Do not edit the runlevel configuration manually. Otherwise SuSEconfig (run by
YaST) will overwrite these changes on its next run. If you need to make manual
changes here, disable future SuSEconfig changes by setting CHECK_INITTAB in
/etc/sysconfig/suseconfig  to no.

If the runlevel is set to 5, your desktop or X Windows software is probably misconfigured
or corrupted. Examine the log files at /var/log/Xorg.*.log  for detailed
messages from the X server as it attempted to start. If the desktop fails during start, it
may log error messages to /var/log/messages . If these error messages hint at
a configuration problem in the X server, try to fix these issues. If the graphical system
still does not come up, consider reinstalling the graphical desktop.

ПОДСКАЗКА: Starting X Window System Manually

One quick test: the startx command should force the X Window System to start
with the configured defaults if the user is currently logged in on the console. If that
does not work, it should log errors to the console.
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A.2.4 Login Problems

Login problems are those where your machine does, in fact, boot to the expected
welcome screen or login prompt, but refuses to accept the username and password,
or accepts them but then does not behave properly (fails to start the graphic desktop,
produces errors, drops to a command line, etc.).

Valid Username and Password Combinations Fail

This usually occurs when the system is configured to use network authentication or
directory services and, for some reason, is unable to retrieve results from its configured
servers. The root user, as the only local user, is the only user that can still log in to
these machines. The following are some common reasons why a machine appears
functional but is unable to process logins correctly:

• The network is not working. For further directions on this, turn to Раздел A.2.5,
«Network Problems» (стр. 102).

• DNS is not working at the moment (which prevents GNOME or KDE from working
and the system from making validated requests to secure servers). One indication
that this is the case is that the machine takes an extremely long time to respond
to any action. Find more information about this topic in Раздел A.2.5, «Network
Problems» (стр. 102).

• If the system is configured to use Kerberos, the system's local time may have
drifted past the accepted variance with the Kerberos server time (this is typically
300 seconds). If NTP (network time protocol) is not working properly or local NTP
servers are not working, Kerberos authentication ceases to function because it
depends on common clock synchronization across the network.

• The system's authentication configuration is misconfigured. Check the PAM
configuration files involved for any typographical errors or misordering of
directives. For additional background information about PAM and the syntax
of the configuration files involved, refer to Глава 2, Authentication with PAM
(↑Руководство по безопасности).

• The home partition is encrypted. Find more information about this topic in «Login
to Encrypted Home Partition Fails» (стр. 100).

In all cases that do not involve external network problems, the solution is to reboot the
system into single-user mode and repair the configuration before booting again into
operating mode and attempting to log in again. To boot into single-user mode:

1 Reboot the system. The boot screen appears, offering a prompt.

2 Enter 1 at the boot prompt to make the system boot into single-user mode.

3 Enter the username and password for root.

4 Make all the necessary changes.
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5 Boot into the full multiuser and network mode by entering telinit 5 at the
command line.

Valid Username and Password Not Accepted

This is by far the most common problem users encounter, because there are many
reasons this can occur. Depending on whether you use local user management and
authentication or network authentication, login failures occur for different reasons.

Local user management can fail for the following reasons:

• The user may have entered the wrong password.

• The user's home directory containing the desktop configuration files is corrupted
or write protected.

• There may be problems with the X Window System authenticating this particular
user, especially if the user's home directory has been used with another Linux
distribution prior to installing the current one.

To locate the reason for a local login failure, proceed as follows:

1 Check whether the user remembered his password correctly before you start
debugging the whole authentication mechanism. If the user may not remember
his password correctly, use the YaST User Management module to change the
user's password. Pay attention to the [Caps Lock] key and unlock it, if necessary.

2 Log in as root and check /var/log/messages  for error messages of the
login process and of PAM.

3 Try to log in from a console (using [Ctrl] + [Alt] + [F1]). If this is successful, the
blame cannot be put on PAM, because it is possible to authenticate this user
on this machine. Try to locate any problems with the X Window System or the
desktop (GNOME or KDE). For more information, refer to «Login Successful but
GNOME Desktop Fails» (стр. 100) and «Login Successful but KDE Desktop
Fails» (стр. 101).

4 If the user's home directory has been used with another Linux distribution,
remove the Xauthority file in the user's home. Use a console login via [Ctrl]
+ [Alt] + [F1] and run rm .Xauthority as this user. This should eliminate X
authentication problems for this user. Try graphical login again.

5 If graphical login still fails, do a console login with [Ctrl] + [Alt] + [F1]. Try to start
an X session on another display—the first one (:0) is already in use:

startx -- :1

This should bring up a graphical screen and your desktop. If it does not, check
the log files of the X Window System (/var/log/Xorg. displaynumber

.log ) or the log file for your desktop applications (.xsession-errors  in
the user's home directory) for any irregularities.
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6 If the desktop could not start because of corrupt configuration files, proceed
with «Login Successful but GNOME Desktop Fails» (стр. 100) or «Login
Successful but KDE Desktop Fails» (стр. 101).

The following are some common reasons why network authentication for a particular
user may fail on a specific machine:

• The user may have entered the wrong password.

• The username exists in the machine's local authentication files and is also
provided by a network authentication system, causing conflicts.

• The home directory exists but is corrupt or unavailable. Perhaps it is write
protected or is on a server that is inaccessible at the moment.

• The user does not have permission to log in to that particular host in the
authentication system.

• The machine has changed hostnames, for whatever reason, and the user does
not have permission to log in to that host.

• The machine cannot reach the authentication server or directory server that
contains that user's information.

• There may be problems with the X Window System authenticating this particular
user, especially if the user's home has been used with another Linux distribution
prior to installing the current one.

To locate the cause of the login failures with network authentication, proceed as follows:

1 Check whether the user remembered their password correctly before you start
debugging the whole authentication mechanism.

2 Determine the directory server which the machine relies on for authentication
and make sure that it is up and running and properly communicating with the
other machines.

3 Determine that the user's username and password work on other machines to
make sure that his authentication data exists and is properly distributed.

4 See if another user can log in to the misbehaving machine. If another user can
log in without difficulty or if root can log in, log in and examine the /var/log/
messages  file. Locate the time stamps that correspond to the login attempts
and determine if PAM has produced any error messages.

5 Try to log in from a console (using [Ctrl] + [Alt] + [F1]). If this is successful, the
problem is not with PAM or the directory server on which the user's home is
hosted, because it is possible to authenticate this user on this machine. Try to
locate any problems with the X Window System or the desktop (GNOME or
KDE). For more information, refer to «Login Successful but GNOME Desktop
Fails» (стр. 100) and «Login Successful but KDE Desktop Fails» (стр. 101).

6 If the user's home directory has been used with another Linux distribution,
remove the Xauthority file in the user's home. Use a console login via [Ctrl]
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+ [Alt] + [F1] and run rm .Xauthority as this user. This should eliminate X
authentication problems for this user. Try graphical login again.

7 If graphical login still fails, do a console login with [Ctrl] + [Alt] + [F1]. Try to start
an X session on another display—the first one (:0) is already in use:

startx -- :1

This should bring up a graphical screen and your desktop. If it does not, check
the log files of the X Window System (/var/log/Xorg. displaynumber

.log ) or the log file for your desktop applications (.xsession-errors  in
the user's home directory) for any irregularities.

8 If the desktop could not start because of corrupt configuration files, proceed
with «Login Successful but GNOME Desktop Fails» (стр. 100) or «Login
Successful but KDE Desktop Fails» (стр. 101).

Login to Encrypted Home Partition Fails
It is recommended to use an encrypted home partition for laptops. If you cannot log in
to your laptop, the reason is usually simple: your partition could not be unlocked.

During the boot time, you have to enter the passphrase to unlock your encrypted
partition. If you do not enter it, the boot process continues, leaving the partition locked.

To unlock your encrypted partition, proceed as follows:

1 Switch to the text console with [Ctrl] + [Alt] + [F1].

2 Become root.

3 Restart the unlocking process again with:

/etc/init.d/boot.crypto restart

4 Enter your passphrase to unlock your encrypted partition.

5 Exit the text console and switch back to the login screen with [Alt] + [F7].

6 Log in as usual.

Login Successful but GNOME Desktop Fails

If this is the case, it is likely that your GNOME configuration files have become
corrupted. Some symptoms may include the keyboard failing to work, the screen
geometry becoming distorted, or even the screen coming up as a bare gray field. The
important distinction is that if another user logs in, the machine works normally. It is
then likely that the problem can be fixed relatively quickly by simply moving the user's
GNOME configuration directory to a new location, which causes GNOME to initialize
a new one. Although the user is forced to reconfigure GNOME, no data is lost.

1 Switch to a text console by pressing [Ctrl] + [Alt] + [F1].
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2 Log in with your user name.

3 Move the user's GNOME configuration directories to a temporary location:
mv .gconf  .gconf-ORIG-RECOVER
mv .gnome2 .gnome2-ORIG-RECOVER

4 Log out.

5 Log in again, but do not run any applications.

6 Recover your individual application configuration data (including the Evolution
e-mail client data) by copying the ~/.gconf-ORIG-RECOVER/apps/
directory back into the new ~/.gconf  directory as follows:
cp -a .gconf-ORIG-RECOVER/apps .gconf/

If this causes the login problems, attempt to recover only the critical application
data and reconfigure the remainder of the applications.

Login Successful but KDE Desktop Fails

There are several reasons why a KDE desktop would not allow users to login.
Corrupted cache data can cause login problems as well as corrupt KDE desktop
configuration files.

Cache data is used at desktop start-up to increase performance. If this data is
corrupted, start-up is slowed down or fails entirely. Removing them forces the desktop
start-up routines to start from scratch. This takes more time than a normal start-up, but
data is intact after this and the user can login.

To remove the cache files of the KDE desktop, issue the following command as root:
rm -rf /tmp/kde-user /tmp/ksocket-user

Replace user with your username. Removing these two directories just removes the
corrupted cache files. No real data is harmed using this procedure.

Corrupted desktop configuration files can always be replaced with the initial
configuration files. If you want to recover the user's adjustments, carefully copy them
back from their temporary location after the configuration has been restored, using the
default configuration values.

To replace a corrupted desktop configuration with the initial configuration values,
proceed as follows:

1 Switch to a text console by pressing [Ctrl] + [Alt] + [F1].

2 Log in with your username.

3 Move the KDE configuration directory and the .skel  files to a temporary
location:

• For KDE3 use these commands:
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mv .kde  .kde-ORIG-RECOVER 
mv .skel .skel-ORIG-RECOVER

• For KDE4 use these commands:

mv .kde4  .kde4-ORIG-RECOVER 
mv .skel .skel-ORIG-RECOVER

4 Log out.

5 Log in again.

6 After the desktop has started successfully, copy the user's own configurations
back into place:

cp -a KDEDIR/share .kde/share

Replace KDEDIR with the directory from Шаг 3 (стр. 101).

ВАЖНО

If the user's own adjustments caused the login to fail and continue to do
so, repeat the procedure as described above, but do not copy the .kde/
share  directory.

A.2.5 Network Problems

Many problems of your system may be network-related, even though they do not seem
to be at first. For example, the reason for a system not allowing users to log in may be
a network problem of some kind. This section introduces a simple check list you can
apply to identify the cause of any network problem encountered.

Процедура A.6 How to Identify Network Problems

When checking the network connection of your machine, proceed as follows:

1 If you use an ethernet connection, check the hardware first. Make sure that your
network cable is properly plugged into your computer and router (or hub, etc.).
The control lights next to your ethernet connector are normally both be active.

If the connection fails, check whether your network cable works with another
machine. If it does, your network card causes the failure. If hubs or switches
are included in your network setup, they may be faulty, as well.

2 If using a wireless connection, check whether the wireless link can be
established by other machines. If not, contact the wireless network's
administrator.

3 Once you have checked your basic network connectivity, try to find out which
service is not responding. Gather the address information of all network servers
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needed in your setup. Either look them up in the appropriate YaST module
or ask your system administrator. The following list gives some of the typical
network servers involved in a setup together with the symptoms of an outage.

DNS (Name Service)
A broken or malfunctioning name service affects the network's functionality
in many ways. If the local machine relies on any network servers for
authentication and these servers cannot be found due to name resolution
issues, users would not even be able to log in. Machines in the network
managed by a broken name server would not be able to «see» each other
and communicate.

NTP (Time Service)
A malfunctioning or completely broken NTP service could affect Kerberos
authentication and X server functionality.

NFS (File Service)
If any application needs data stored in an NFS mounted directory, it will not
be able to start or function properly if this service was down or misconfigured.
In the worst case scenario, a user's personal desktop configuration would
not come up if their home directory containing the .gconf  or .kde
subdirectories could not be found due to a faulty NFS server.

Samba (File Service)
If any application needs data stored in a directory on a faulty Samba server,
it will not be able to start or function properly.

NIS (User Management)
If your openSUSE system relies on a faulty NIS server to provide the user
data, users will not be able to log in to this machine.

LDAP (User Management)
If your openSUSE system relies on a faulty LDAP server to provide the user
data, users will not be able to log in to this machine.

Kerberos (Authentication)
Authentication will not work and login to any machine fails.

CUPS (Network Printing)
Users cannot print.

4 Check whether the network servers are running and whether your network setup
allows you to establish a connection:

ВАЖНО

The debugging procedure described below only applies to a simple network
server/client setup that does not involve any internal routing. It assumes
both server and client are members of the same subnet without the need for
additional routing.
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4a Use ping IP address or hostname (replace hostname with
the hostname of the server) to check whether each one of them is up
and responding to the network. If this command is successful, it tells
you that the host you were looking for is up and running and that the
name service for your network is configured correctly.

If ping fails with destination host unreachable, either your
system or the desired server is not properly configured or down.
Check whether your system is reachable by running ping IP

address or your_hostname  from another machine. If you can
reach your machine from another machine, it is the server that is not
running at all or not configured correctly.

If ping fails with unknown host, the name service is not configured
correctly or the hostname used was incorrect. For further checks on
this matter, refer to Шаг 4b (стр. 104). If ping still fails, either your
network card is not configured correctly or your network hardware
is faulty.

4b Use host hostname to check whether the hostname of the server
you are trying to connect to is properly translated into an IP address
and vice versa. If this command returns the IP address of this host,
the name service is up and running. If the host command fails,
check all network configuration files relating to name and address
resolution on your host:

/etc/resolv.conf
This file is used to keep track of the name server and domain you
are currently using. It can be modified manually or automatically
adjusted by YaST or DHCP. Automatic adjustment is preferable.
However, make sure that this file has the following structure and
all network addresses and domain names are correct:

search fully_qualified_domain_name
nameserver ipaddress_of_nameserver

This file can contain more than one name server address, but
at least one of them must be correct to provide name resolution
to your host. If needed, adjust this file using the YaST Network
Setting module (Hostname/DNS tab).

If your network connection is handled via DHCP, enable DHCP
to change hostname and name service information by selecting
Change Hostname via DHCP and Update Name Servers and
Search List via DHCP in the YaST DNS and Hostname module.

/etc/nsswitch.conf
This file tells Linux where to look for name service information.
It should look like this:
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 ...
hosts: files dns
networks: files dns
...

The dns entry is vital. It tells Linux to use an external name server.
Normally, these entries are automatically managed by YaST, but
it would be prudent to check.

If all the relevant entries on the host are correct, let your system
administrator check the DNS server configuration for the correct
zone information. For detailed information about DNS, refer to
Глава 25, The Domain Name System (↑Reference). If you have
made sure that the DNS configuration of your host and the DNS
server are correct, proceed with checking the configuration of
your network and network device.

4c If your system cannot establish a connection to a network server and
you have excluded name service problems from the list of possible
culprits, check the configuration of your network card.

Use the command ifconfig network_device (executed as
root) to check whether this device was properly configured. Make
sure that both inet address and Mask are configured correctly. An
error in the IP address or a missing bit in your network mask would
render your network configuration unusable. If necessary, perform
this check on the server as well.

4d If the name service and network hardware are properly
configured and running, but some external network connections
still get long time-outs or fail entirely, use traceroute

fully_qualified_domain_name (executed as root) to track
the network route these requests are taking. This command lists any
gateway (hop) that a request from your machine passes on its way
to its destination. It lists the response time of each hop and whether
this hop is reachable at all. Use a combination of traceroute and ping
to track down the culprit and let the administrators know.

Once you have identified the cause of your network trouble, you can resolve it yourself
(if the problem is located on your machine) or let the system administrators of your
network know about your findings so they can reconfigure the services or repair the
necessary systems.

NetworkManager Problems

If you have a problem with network connectivity, narrow it down as described in
Процедура A.6, «How to Identify Network Problems» (стр. 102). If NetworkManager
seems to be the culprit, proceed as follows to get logs providing hints on why
NetworkManager fails:
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1 Open a shell and log in as root.

2 Restart the NetworkManager:

rcnetwork restart -o nm

3 Open a web page, for example, http://www.opensuse.org  as normal
user to see, if you can connect.

4 Collect any information about the state of NetworkManager in /var/log/
NetworkManager .

For more information about NetworkManager, refer to Глава 35, Using
NetworkManager (↑Reference).

A.2.6 Data Problems

Data problems are when the machine may or may not boot properly but, in either case,
it is clear that there is data corruption on the system and that the system needs to
be recovered. These situations call for a backup of your critical data, enabling you to
recover the system state from before your system failed. openSUSE offers dedicated
YaST modules for system backup and restoration as well as a rescue system that can
be used to recover a corrupted system from the outside.

Managing Partition Images

Sometimes you need to perform a backup from an entire partition or even hard disk.
Linux comes with the dd tool which can create an exact copy of your disk. Combined
with gzip you save some space.

Процедура A.7 Backing up and Restoring Harddisks

1 Start a Shell as user root.

2 Select your source device. Typically this is something like /dev/sda  (labeled
as SOURCE).

3 Decide where you want to store your image (labeled as BACKUP_PATH). It must
be different from your source device. In other words: if you make a backup from
/dev/sda , your image file must not be stored under /dev/sda .

4 Run the commands to create a compressed image file:

dd if=/dev/SOURCE | gzip > /BACKUP_PATH/image.gz 

5 Restore the hard disk with the following commands:

gzip -dc /BACKUP_PATH/image.gz | dd of=/dev/SOURCE

If you only need a partition to backup, replace the SOURCE placeholder with your
respective partition. In this case, your image file can lie on the same hard disk, but on
a different partition.

http://www.opensuse.org
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Backing Up Critical Data

System backups can be easily managed using the YaST System Backup module:

1 As root, start YaST and select System > System Backup.

2 Create a backup profile holding all details needed for the backup, filename of
the archive file, scope, and type of the backup:

2a Select Profile Management > Add.

2b Enter a name for the archive.

2c Enter the path to the location of the backup if you want to keep a local
backup. For your backup to be archived on a network server (via
NFS), enter the IP address or name of the server and the directory
that should hold your archive.

2d Determine the archive type and click Next.

2e Determine the backup options to use, such as whether files not
belonging to any package should be backed up and whether a list of
files should be displayed prior to creating the archive. Also determine
whether changed files should be identified using the time-consuming
MD5 mechanism.

Use Expert to enter a dialog for the backup of entire hard disk areas.
Currently, this option only applies to the Ext2 file system.

2f Finally, set the search constraints to exclude certain system areas
from the backup area that do not need to be backed up, such as lock
files or cache files. Add, edit, or delete items until your needs are
met and leave with OK.

3 Once you have finished the profile settings, you can start the backup right away
with Create Backup or configure automatic backup. It is also possible to create
other profiles tailored for various other purposes.

To configure automatic backup for a given profile, proceed as follows:

1 Select Automatic Backup from the Profile Management menu.

2 Select Start Backup Automatically.

3 Determine the backup frequency. Choose daily, weekly, or monthly.

4 Determine the backup start time. These settings depend on the backup
frequency selected.

5 Decide whether to keep old backups and how many should be kept. To receive
an automatically generated status message of the backup process, check Send
Summary Mail to User root.
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6 Click OK to apply your settings and have the first backup start at the time
specified.

Restoring a System Backup

Use the YaST System Restoration module to restore the system configuration from a
backup. Restore the entire backup or select specific components that were corrupted
and need to be reset to their old state.

1 Start YaST > System > System Restoration.

2 Enter the location of the backup file. This could be a local file, a network mounted
file, or a file on a removable device, such as a floppy or a DVD. Then click Next.

The following dialog displays a summary of the archive properties, such as the
filename, date of creation, type of backup, and optional comments.

3 Review the archived content by clicking Archive Content. Clicking OK returns
you to the Archive Properties dialog.

4 Expert Options opens a dialog in which to fine-tune the restore process. Return
to the Archive Properties dialog by clicking OK.

5 Click Next to open the view of packages to restore. Press Accept to restore
all files in the archive or use the various Select All, Deselect All, and Select
Files buttons to fine-tune your selection. Only use the Restore RPM Database
option if the RPM database is corrupted or deleted and this file is included in
the backup.

6 After you click Accept, the backup is restored. Click Finish to leave the module
after the restore process is completed.

A.2.7 Recovering a Corrupted System
There are several reasons why a system could fail to come up and run properly.
A corrupted file system following a system crash, corrupted configuration files, or a
corrupted boot loader configuration are the most common ones.

Using the Rescue System

openSUSE contains a rescue system. The rescue system is a small Linux system that
can be loaded into a RAM disk and mounted as root file system, allowing you to access
your Linux partitions from the outside. Using the rescue system, you can recover or
modify any important aspect of your system:

• Manipulate any type of configuration file.

• Check the file system for defects and start automatic repair processes.

• Access the installed system in a «change root» environment.

• Check, modify, and reinstall the boot loader configuration.
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• Resize partitions using the parted command. Find more information about
this tool at the GNU Parted website http://www.gnu.org/software/
parted/parted.html .

The rescue system can be loaded from various sources and locations. The simplest
option is to boot the rescue system from the original installation medium:

1 Insert the installation medium into your DVD drive.

2 Reboot the system.

3 At the boot screen, press [F4] and choose DVD-ROM. Then choose Rescue
System from the main menu.

4 Enter root at the Rescue: prompt. A password is not required.

If your hardware setup does not include a DVD drive, you can boot the rescue system
from a network source (including the openSUSE FTP server). The following example
applies to a remote boot scenario—if using another boot medium, such as a DVD,
modify the info file accordingly and boot as you would for a normal installation.

1 Enter the configuration of your PXE boot setup and add the lines
install=protocol://instsource and rescue=1. If you need to start the
repair system, use repair=1 instead. As with a normal installation, protocol
stands for any of the supported network protocols (NFS, HTTP, FTP, etc.) and
instsource for the path to your network installation source.

2 Boot the system using «Wake on LAN», as described in Раздел “Wake on
LAN” (Глава 2, Remote Installation, ↑Reference).

3 Enter root at the Rescue: prompt. A password is not required.

Once you have entered the rescue system, you can make use of the virtual consoles
that can be reached with [Alt] + [F1] to [Alt] + [F6].

A shell and many other useful utilities, such as the mount program, are available in
the /bin directory. The sbin directory contains important file and network utilities for
reviewing and repairing the file system. This directory also contains the most important
binaries for system maintenance, such as fdisk, mkfs, mkswap, mount, mount, init, and
shutdown, and ifconfig, ip, route, and netstat for maintaining the network. The directory
/usr/bin  contains the vi editor, find, less, and ssh.

To see the system messages, either use the command dmesg or view the file /var/
log/messages .

Checking and Manipulating Configuration Files

As an example for a configuration that might be fixed using the rescue system, imagine
you have a broken configuration file that prevents the system from booting properly.
You can fix this using the rescue system.

http://www.gnu.org/software/parted/parted.html
http://www.gnu.org/software/parted/parted.html
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To manipulate a configuration file, proceed as follows:

1 Start the rescue system using one of the methods described above.

2 To mount a root file system located under /dev/sda6  to the rescue system,
use the following command:

mount /dev/sda6 /mnt

All directories of the system are now located under /mnt

3 Change the directory to the mounted root file system:

cd /mnt

4 Open the problematic configuration file in the vi editor. Adjust and save the
configuration.

5 Unmount the root file system from the rescue system:

umount /mnt

6 Reboot the machine.

Repairing and Checking File Systems

Generally, file systems cannot be repaired on a running system. If you encounter
serious problems, you may not even be able to mount your root file system and the
system boot may end with a «kernel panic». In this case, the only way is to repair the
system from the outside. The rescue system provides all tools needed for a manual
file system check or repair. It contains the utilities to check and repair the ext2, ext3,
ext4, reiserfs, xfs, dosfs, and vfat file systems.

Accessing the Installed System

If you need to access the installed system from the rescue system to, you need to do
this in a change root environment. For example, to modify the boot loader configuration,
or to execute a hardware configuration utility.

To set up a change root environment based on the installed system, proceed as follows:

1 First mount the root partition from the installed system and the device file system
(change the device name to your current settings):

mount /dev/sda6 /mnt
mount --bind /dev /mnt/dev

2 Now you can «change root» into the new environment:

chroot /mnt

3 Then mount /proc and /sys:

mount /proc
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mount /sys

4 Finally, mount the remaining partitions from the installed system:

mount -a

5 Now you have access to the installed system. Before rebooting the system,
unmount the partitions with umount -a and leave the «change root»
environment with exit.

ВНИМАНИЕ: Limitations

Although you have full access to the files and applications of the installed system,
there are some limitations. The kernel that is running is the one that was booted with
the rescue system, not with the change root environment. It only supports essential
hardware and it is not possible to add kernel modules from the installed system
unless the kernel versions are exactly the same (which is unlikely). So you cannot
access a sound card, for example. It is also not possible to start a graphical user
interface.

Also note that you leave the «change root» environment when you switch the
console with [Alt] + [F1] to [Alt] + [F6].

Modifying and Reinstalling the Boot Loader

Sometimes a system cannot boot because the boot loader configuration is corrupted.
The start-up routines cannot, for example, translate physical drives to the actual
locations in the Linux file system without a working boot loader.

To check the boot loader configuration and reinstall the boot loader, proceed as follows:

1 Perform the necessary steps to access the installed system as described in
«Accessing the Installed System» (стр. 110).

2 Check whether the following files are correctly configured according to the
GRUB configuration principles outlined in Глава 18, The Boot Loader GRUB
(↑Reference) and apply fixes if necessary.

• /etc/grub.conf

• /boot/grub/device.map

• /boot/grub/menu.lst

• /etc/sysconfig/bootloader

3 Reinstall the boot loader using the following command sequence:

grub --batch < /etc/grub.conf

4 Unmount the partitions, log out from the «change root» environment, and reboot
the system:
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umount -a
exit
reboot
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accept the license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/
or translated into another language.

A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or
authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject.
(Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter
of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The «Invariant Sections» are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says
that the Document is released under this License. If a section does not fit the above definition of Secondary then it is not allowed to be designated as
Invariant. The Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

http://www.novell.com/company/legal/trademarks/tmlist.html
http://www.novell.com/company/legal/trademarks/tmlist.html
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The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document
is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A «Transparent» copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public,
that is suitable for revising the document straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for
drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable
for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart
or discourage subsequent modification by readers is not Transparent. An image format is not Transparent if used for any substantial amount of text.
A copy that is not «Transparent» is called «Opaque».

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using
a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed for human modification. Examples of transparent image
formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word processors,
SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced
by some word processors for output purposes only.

The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License
requires to appear in the title page. For works in formats which do not have any title page as such, «Title Page» means the text near the most prominent
appearance of the work’s title, preceding the beginning of the body of the text.

A section «Entitled XYZ» means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in parentheses following text that
translates XYZ in another language. (Here XYZ stands for a specific section name mentioned below, such as «Acknowledgements», «Dedications»,
«Endorsements», or «History».) To «Preserve the Title» of such a section when you modify the Document means that it remains a section «Entitled
XYZ» according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the Document. These Warranty Disclaimers
are considered to be included by reference in this License, but only as regards disclaiming warranties: any other implication that these Warranty
Disclaimers may have is void and has no effect on the meaning of this License.

VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices,
and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to
those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions
in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 100, and the Document’s
license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on
the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition.
Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim
copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover,
and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy
along with each Opaque copy, or state in or with each Opaque copy a computer-network location from which the general network-using public has
access to download using public-standard network protocols a complete Transparent copy of the Document, free of added material. If you use the latter
option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will
remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents
or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a
chance to provide you with an updated version of the Document.

MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified
Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified
Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A.  Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if
there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that
version gives permission.

B.  List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with
at least five of the principal authors of the Document (all of its principal authors, if it has fewer than five), unless they release you from this requirement.

C.  State on the Title page the name of the publisher of the Modified Version, as the publisher.

D.  Preserve all the copyright notices of the Document.

E.  Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F.  Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this
License, in the form shown in the Addendum below.

G.  Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license notice.

H.  Include an unaltered copy of this License.

I.  Preserve the section Entitled «History», Preserve its Title, and add to it an item stating at least the title, year, new authors, and publisher of the
Modified Version as given on the Title Page. If there is no section Entitled «History» in the Document, create one stating the title, year, authors, and
publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.



114 Вступление

J.  Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network
locations given in the Document for previous versions it was based on. These may be placed in the «History» section. You may omit a network location
for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

K.  For any section Entitled «Acknowledgements» or «Dedications», Preserve the Title of the section, and preserve in the section all the substance
and tone of each of the contributor acknowledgements and/or dedications given therein.

L.  Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered
part of the section titles.

M.  Delete any section Entitled «Endorsements». Such a section may not be included in the Modified Version.

N.  Do not retitle any existing section to be Entitled «Endorsements» or to conflict in title with any Invariant Section.

O.  Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the
Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled «Endorsements», provided it contains nothing but endorsements of your Modified Version by various parties--for
example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of
Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements
made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the
same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher
that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply
endorsement of any Modified Version.

COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions,
provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there
are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in
parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section
titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled «History» in the various original documents, forming one section Entitled «History»; likewise
combine any sections Entitled «Acknowledgements», and any sections Entitled «Dedications». You must delete all sections Entitled «Endorsements».

COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and replace the individual copies of this
License in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim
copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert a copy of this License
into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution
medium, is called an “aggregate” if the copyright resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond
what the individual works permit. When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one half of the entire
aggregate, the Document’s Cover Texts may be placed on covers that bracket the Document within the aggregate, or the electronic equivalent of covers
if the Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole aggregate.

TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant
Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in
addition to the original versions of these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the original versions of those notices and
disclaimers. In case of a disagreement between the translation and the original version of this License or a notice or disclaimer, the original version
will prevail.

If a section in the Document is Entitled «Acknowledgements», «Dedications», or «History», the requirement (section 4) to Preserve its Title (section
1) will typically require changing the actual title.

TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy, modify,
sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License «or
any later version» applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has
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been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices
just after the title page:

   Copyright (c) YEAR YOUR NAME.
   Permission is granted to copy, distribute and/or modify this document
   under the terms of the GNU Free Documentation License, Version 1.2
   or any later version published by the Free Software Foundation;
   with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
   A copy of the license is included in the section entitled “GNU
   Free Documentation License”.
  

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with...Texts.” line with this:

   with the Invariant Sections being LIST THEIR TITLES, with the
   Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.
  

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software
license, such as the GNU General Public License, to permit their use in free software.
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